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WARNING

Read this entire manual and all other publications pertaining to the work to be
performed before installing, operating, or servicing this equipment. Practice all
plant and safety instructions and precautions. Failure to follow instructions can
cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an
overspeed shutdown device to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover
control system. An overtemperature or overpressure shutdown device may also be
needed for safety, as appropriate.

CAUTION

To prevent damage to a control system that uses an alternator or battery-charging
device, make sure the charging device is turned off before disconnecting the battery
from the system.

Electronic controls contain static-sensitive parts. Observe the following precautions

to prevent damage to these parts.

e Discharge body static before handling the control (with power to the control
turned off, contact a grounded surface and maintain contact while handling the
control).

¢ Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around
printed circuit boards.

e Do not touch the components or conductors on a printed circuit board with
your hands or with conductive devices.

IMPORTANT DEFINITIONS

WARNING—indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury.

CAUTION—indicates a potentially hazardous situation which, if not avoided, could
result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or
caution categories.

Woodward Governor Company reserves the right to update any portion of this publication at any time. Information
provided by Woodward Governor Company is believed to be correct and reliable. However, no responsibility is
assumed by Woodward Governor Company unless otherwise expressly undertaken.

© Woodward 2004
All Rights Reserved
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Chapter 1.

Understanding the sttem

System Basics

The APECS (Advanced Proportional Engine Control System) product line manufactured
by Woodward provides a family of electronic controllers and actuators intended for use
as speed governors on a wide range of diesel and spark ignition engines. The
controllers are microprocessor-based modules and will maintain desired engine speed
despite changes in engine load. Governors are found on a variety of engine-driven
products, both stationary and mobile, such as generators, hydraulic pumps,
compressors and utility vehicles.

Electronic engine governors work by electronically sensing engine speed, comparing
the actual engine speed to the desired speed commanded by the operator, and
adjusting the command to an actuator attached to the engine throttle lever or
mechanical fuel injection pump. Desired engine speed may be fixed or selected with
one or more switches, a potentiometer, or some other means. A schematic
representation of the APECS 5000 system is shown in Figure 1.

APECS 2000, 3000, 4000, and 4500 were designed to drive any of the many
Woodward proportional actuators. The APECS 5000 controller was designed for use
with a Woodward rotary stepper motor actuator that has been environmentally
hardened for use on engines. This actuator converts pulse commands from the
controller to a rotary position, such as that required to move the throttle of a small
engine. Stepper motors provide high torque in a small package with a low current
requirement. APECS 5000 is ideally suited for use on small (one- or two-cylinder) spark
ignition (gasoline, CNG, LPG) engines.

The APECS 5000 system provides either isochronous (engine speed remains fixed,
regardless of load) or droop engine governing over a wide speed range.

APECS 5000 is compatible with most common means of sensing engine speed such as
magnetic pickups, ignition systems and Hall Effect sensors.

Inputs are user-configurable for a wide variety of on- and off-highway applications.
Desired engine speed can be preset or based on a pedal input, switch inputs, or a
combination or the two.

An engine protection switch input and an auxiliary output assist the user in getting the
maximum value out of a single electronic module.

é WARNING
An overspeed shutdown device, independent of the APECS
system, should be provided to prevent loss of engine control that
may cause personal injury or equipment damage.

Woodward 1
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ENGINE SPEED SIGNAL

STEFFER
MOTOR
ACTUATOR

SPEED SETPOINT SWITCHES

PULSE OUTPUT

ANALOG SPEED INPUT

APECS
CONTROLLER PC
|IDLE WERIFICATION SWWITCH CALIBRATION
TooL
FTO ENABLE SWITCH
ENGINE PROTECTION SYWITCH AUKILARY OUTPUT

1

POWER

Figure 1. APECS 500 Engine Control System

System Components

The four main components of a complete APECS installation are the APECS controller,
speed sensor, stepper motor actuator, and linkage. A fifth device, the All-purpose
Calibration Tool (ACT), is required for initial configuration and diagnosis of the controller.
In addition to the main components, and depending on the features selected, several
subcomponents (such as switches and potentiometers) may be required. Each
component contributes to the overall performance of the system and shortcomings in any
of the components will detract from total system performance.

APECS Controller

The APECS 5000 series controller is an electronic engine
governor that provides a means of controlling and limiting
engine speed by adjusting the fuel control lever with a
stepper motor actuator. The APECS controller may be
programmed to operate at a single set speed or respond to
operator commands from a potentiometer (e.g. pedal
potentiometer), switches or a combination of the two. It
operates in either isochronous or droop mode, where droop
is user selectable up to 15%.

The controller is software programmable and has no manual
adjustments. A calibration tool (ACT) is used for programming
(configuring and adjusting) the APECS 5000 controller.

2 Woodward
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Calibration Tool (ACT)

The All-purpose Calibration Tool (ACT) is a PC (personal computer)
based software calibration and monitoring tool. ACT is designed
specifically for use with engines equipped with the APECS 5000
controller. The tool can be run on any IBM compatible computer that
meets the requirements listed in “ACT Installation.”

Once the APECS 5000 controller has been programmed, ACT may
be disconnected. The APECS 5000 unit will continue to operate
normally with ACT either connected or disconnected.

Speed Sensor

APECS 5000 monitors engine speed continuously. Engine speed may be sensed by
monitoring the frequency of spark events in spark-ignition engines or through the use of a
sensor that detects the passing of teeth on an engine driven gear (e.g., flywheel). The
universal speed input of the APECS 5000 is compatible with the following types of speed
input signal:

e Magnetic pickup. See photo below of mag pickups available from Woodward.

e Coil-type spark ignition. Speedcan be
sensed from the negative side of the
coil primary winding.

e Magneto spark ignition. Speed can
be sensed from the spark kill wire on
the primary winding, but will not work
if a diode is placed between the
magneto and the APECS input (may
be found on some multi-cylinder
engines with magneto ignitions.

e  Hall Effect sensor

The speed input may not work with certain types of speed input such as the Ford TFI
system that vary the charging voltage to the coil.

Stepper Motor Actuator

Stepper motors provide a compact, low current, high torque
means of throttle actuation on small engines. Unlike a
proportional solenoid, which traverses its full range of travel by
increasing the current of a single high-current winding, a bi-polar
stepper motor has two low-current windings and is moved by
alternating the current and current polarity in the two windings.
Woodward stepper motors move by rotating in steps of 1.8
degrees. The degrees rotated, the speed of rotation and the
direction of rotation are easily controlled using pulsed signals from
the controller.

—

|
Figure 2. Woodward Stepper Motor Actuator for APECS 5000 Controllers

Woodward 3
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The sequence for pulsing
the coils is shown in the
table at left. To move the
stepper motor shaft in a

counter clockwise
STEP COIL A CoiLB direction, follow the step
sequence from 1 through
1 Fwd Fwd 4 then repeat until the
(2P 2 Fwd Rev @  desired position is
99 'S reached. To move the
=5 3 Rev Rev < stepper motor shaft in the
% gllf 4 Rev Fwd 8 clockwise direction,
© follow the step sequence
1 Fwd Fwd from 4 through 1 then

repeat until the desired
position is reached.

Steps of less than 1.8 degrees can be obtained through a process called microstepping
whereby the current levels are altered without changing the direction of current flow.
APECS 5000 is capable of one-eighth-step resolution, which translates to 0.225
degrees.

It is possible for a stepper motor to “lose steps” when a resistive torque higher than the
stepper torque is encountered (or bumping the throttle by hand). When this happens,
the stepper motor will skip to the nearest step with the same coil polarity, which will be
some multiple of four steps away from the desired position. Unlike a proportional
solenoid, the stepper motor does not automatically return to the desired position when
the resistive torque is removed but remains in its last position. The APECS 5000
controller has logic to detect and recover from lost steps.

If the stepper motor is pulsed faster than it can respond, it may lose steps. Each step is
a complex interaction of position, velocity, torque and inertia. For a stepper motor at
rest and receiving a one step command, the rotor will accelerate from rest and actually
pass the desired position before settling to the desired position. Motion is typically
underdamped and several oscillations will occur. If a second step command occurs
while the rotor is moving past the desired position, it will work to assist the motion.
Similarly, if a second step command occurs while the rotor is moving in a backwards
direction, motion will be hindered and steps may be lost. APECS 5000 has the ability to
specify the stepper motor pulse interval and a brief delay when reversing direction or
following a start/stop/start command.

The primary differences between a stepper motor and a proportional solenoid actuator
are outlined in the chart below.

Wires 4 2
Current Low High
Spring return No Yes
Bi-directional actuation Yes No
Shuts off on loss of power No Yes
Returns when perturbed No Yes
Force/Size High Low
Motion Steps Continuous
Cost Low High

4 Woodward
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Stepper Motor Dimensions

Mating Connector: Delphi 12162188-B
Mating Terminal:  Delphi 12124075 (4 required)

5
[6F,34 mml
25
[6,3% mm]
197
[5.00 mml
[=1:] -
a7 " o8 — g 2507
(2459 mm] o [D — (635 mm]
4-PINS CONNECTOR 69
[17.65 mm]

Figure 3. Stepper Motor Actuator Dimensions

2074 "
152,67 mml
1037 " 1037 °
2633 mml ’7[26.33 mml
/:fa_
/ i Ay A} 2.074 "
k) i G2.67 mmd
REL
Blysy g PLACES!
[ M3 SCREW MOUMTING HOLES ) —:’:3:__’/

e,

ACTUATAR ROTATING DIRECTION

Figure 4. Mounting Dimensions
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Brackets and Linkage

The actuator should be mounted to a bracket that
has been designed for adequate strength and
minimum vibration. The actuator is designed to
accept M3x.5 metric nuts.

The linkage connects the actuator shaft to the
engine control lever. A good linkage allows for
misalignments in both shaft angle and shaft offset
and contributes to accurate, stable and responsive
performance. Either a commercially available shaft
coupling may be used, or a simple linkage
fabricated using two levers and a lightweight link.
A light return spring on the throttle will eliminate
backlash in the linkage. Any binding in the linkage
will detract from performance and may prevent the
governor from working.

|
THROTTLE /

SHAFT
STEPPER
HELIGAL SHAFT MOTOR
COUPLIMG

LEVERW @ MOTOR
FIGURE 5

Connecting Stepper Motor to Throttle

Programmable Features

The APECS 5000 expands Woodward’s line of programmable engine governors to address the

needs of the mobile equipment industry.

Enhanced input and output capability, combined with a flexible configuration, permits the
controller to easily adapt to a wide variety of engine governing applications.

Following is a list of features available with the APECS 5000.

e Analog Speed Setpoint Input. suitable for use with a potentiometer or an
accelerator pedal position sensor (idle verification available)

e Autocrank: useful for remote operation of engines using an auxiliary output.

e Auxiliary Output: Drives a lamp or relay

e Droop Governing: allows non-isochronous speed governing

e Engine Protection Input: protects against adverse conditions such as loss of
engine oil pressure or excessive coolant temperature

e Engine Start Calibration: useful for applications that require special startup
operation (e.g. warm-up speed, reduced governor gains, missing speed signal)

e Qverspeed / Underspeed Protection

e PID Gain Adjustment: allows governor response to be adjusted by user

e PTO Switch Input: allows selection between analog speed setpoint input and
switched speed setpoint inputs in mobile applications

e Switched Speed Setpoint Inputs: allow multiple speed settings using switches.
This feature can be configured together with the analog input (speed pot) for a

variety of speed select options.

e Stepper Motor Configuration: Permits configuration of stepper range of travel

and direction of travel as well as step speed.

To incorporate any of the above features in your system, refer to the “Features Table”
below to determine if additional hardware installation or software configuration is

required.

Woodward
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Features Table

All features available with the APECS 5000 can be easily installed and configured to
work with your application. Refer to the table below to determine if additional hardware

installation is required. Software setup is always required to properly configure the

feature.

Hardware required for the features is customer supplied and is not sold or supplied by

Woodward.
FEATURE ADDITIgggb|:2|§$WARE
Autocrank Yes
Auxiliary Output Yes
Droop Governing No
Engine Protection Input Yes
Engine Start Calibration No
Overspeed / Underspeed Protection No
PID Gains Adjustment No
PTO Switch Input Yes
Analog Speed Setpoint Input** Yes
Switched Speed Setpoint Inputs** Yes

** See Engine Speed Select Options table below

To incorporate any of these features in your system refer to “Installing the Hardware” to
install the selected feature and “Calibrating APECS Features” to configure the feature

for your application.

Woodward
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Engine Speed Select Option Table

The following speed select options are available with the APECS 5000.

SPEED SELECT OPTIONS
NO ANALOG INPUT Speed Mamentany
Use a speed switch to select up to 4 Switch Switch
discrete speeds or use a momentary OR
switch to manually increase or E’%
decrease speed at preset rates.
SPEED TRIM ke Trim Pot

Use a speed pot (analog input) to trim
the speed switch selected set speed.

AND

&

@

SET SPEED WITH POT
Use a speed pot (analog input) to
adjust set speed.

Speed Pot

&

SET SPEED WITH POT

OR SPEED SWITCH

Use a speed pot (analog input) to
adjust the set speed or use a speed
switch to select up to 4 discrete
speeds. Use the PTO switch to select
between speed pot and speed
switches.

Speed
Fot

OR

Speed
Switch

DRIVE-BY-WIRE

Use pedal pot (analog input) to adjust
set speed. Can be used with or without
IVS. Includes safety startup logic to
assure engine always starts at idle.

DRIVE-BY-WIRE OR SPEED SWITCH
Use a pedal pot (analog input) to adjust
the set speed or use a speed switch to
select up to 4 discrete speeds. Can be
used with or without IVS. Use the PTO
switch to select between pedal pot and
speed switches. Drive-by-Wire mode
assures that the engine will never start
up at a high speed. Commanded speed
will remain at idle until the pedal
returns to idle. The PTO input must
undergo an off-to-on transition before
starting PTO mode.

(u]

Speed
Swiitch

@

Woodward
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Chapter 2.

Installing the Hardware

When installing the APECS hardware, be aware that some of the options
selected may also require hardware setup (see list below). Hardware required
for optional features is not provided or sold by Woodward.

Take adequate protection to ensure personal and equipment safety and follow
the suggested installation sequence given below:

Install main components:

Review Wiring Guidelines
Controller

Speed Sensor

Actuator and Linkage

Install optional components (hardware installation required):

Autocrank

Auxiliary Output

Engine Protection Input

Speed Setpoint—Switched Input
Speed Setpoint—Analog Input
PTO Switch Input

Detailed instructions for installation and wiring are provided in the following
pages.

Wiring Guidelines

APECS 5000 has two 12-pin Deutsch connectors labeled J1 (grey) and
J2 (black). Mating connectors may be purchased from Woodward (part number
SA-4490) or from a Deutsch distributor.

Deutsch part numbers are as follows:

J1(Grey): DTM06-12SA

J2 (Black): DTM06-12SB

Sockets (pins, 12 per connector): 1062-20-0122
Wedgelocks (1 per connector): WM-12S

Blank Pins (to fill empty pins): 0413-204-2005

Always use an appropriate crimping tool for attaching the pins to the wiring
harness. Pay close attention to the pin numbers embossed on each connector.

1. Refer to Figure 5 and Table 1 to install the system and subcomponents

2. Mount the unit in a location where the effects of vibration and temperature are
within the specified range. Operating temperature: -40°F to +185°F (40°C to
+85°C); vibration: 6 G’s from 40 to 2000 Hz. (See Figure 5 for controller
dimensions.)

Woodward 9
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3. Power leads are to be connected directly to a switched power source (i.e.,
battery). Use of a 4 amp, slow-blow fuse is recommended in the battery
(positive) wire.

4.  When operating in a high field-strength environment, use shielded cable for
external speed signal source. Shields should be connected to the battery
ground wire at one end only. Use of twisted pair for battery power and actuator
wiring may also increase immunity.

5. Use of convoluted tubing, conduit or other wire shielding is recommended to
minimize the likelihood of mechanical damage to wires.
Avoid routing wires near sharp edges or near locations that can cause the wires
to be “pinched” or damaged.

6. Woodward recommends the use of 18 AWG (1.00mm?) wire for all connections.
This will assure a good combination of low electrical resistance and mechanical
strength. Wire insulation should be appropriate for engine applications.

Excessive length or inadequate gauge can cause increased wire resistance
that can limit the current to the actuator and prevent full actuator travel

7. Increased electrical resistance can also result from poor wiring techniques. It is
important to use good quality terminations and proper crimping technique
during wiring.

Terminations must be impervious to moisture to prevent shorts and corrosion.
Controller Installation

Controller Wiring

The controller can be installed in the engine compartment (maximum temperature
185°F/85°C.)

4.608" 2.953*

4.000"

|
I

Figure 5. APECS 5000 Dimensions

10 Woodward
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Table 1. Controller Wiring

Stepper Motor Output SP1A (J1-5), SP1B (J1-6), Stepper Phase 1
SP2A (J1-8), SP2B (J1-7), Stepper Phase 2
Analog Input APP (J2-12), Vggr (J2-11), —
SRTN (J2-2)

Auxiliary Output

AUX (J2-4), Vgar (J1-9)

Low side driver

Battery

VBAT (J1-9), GND (J1-4)

Engine Protection Input

EPSW (J2-9), GND (J1-4)

Switch to Ground

Idle Verification

IVS (J2-5), Vaar (J1-9)

Switch to VBAT

Power Take-off

PTO (J2-6), Vaar (J1-9)

Switch to VBAT

Rack Position Sensor

RPS (J2-1)

Not Used

ACT Connector

RCV (J1-12), TXD (J1-1),
Vaso (J1-11), GND2 (J1-2)

Speed Signal Input

RPM+(J1-10), RPM-(J1-3)

Switched Inputs

SW1 (J2-7), SW2 (J2-8),
Viar (J1-9)

Switch to VBAT

Woodward

11



APECS 5000° Electronic Engine Speed Governing System

Manual SE-4096

Controller Pinout

Use the diagram below to connect your APECS controller to ACT, your preferred speed
sensor, and various inputs and outputs.

Calibration Tool Setup

Computer

Interface Module

4-pin mating connector/'”
(Molex 39-01-2040)

TXD (J11)
RCV (J1 12)

.
GND2 (J1 2)
VBB2 (J1 11)

RPM+ (J1 10)

RPM- (J1 3)

Twisted Pair Shielded Wire
(shield grounded at controller only)

\/

Speed Sensor Input

Hall Effect

Twisted Pair Wire

(> 1 twist per inch) SP1A (J1 5)

SP1B (J16)

SP2A (J18
SP2B (J17)

STEPPER MOTOR
ACTUATOR

(> 1 twist per inch)

VREF (J2 11) Analog Speed Input
L APP (J2 12)
N - )
SRTN (J22)
Pot Pedal
A
_______ I
| _vs 25) | Idle Verification !
| (used with pedal input) |
____________ -
>< \ SW1 (J27) Switched Speed Input
SW2 (J28) & Switched
APE ntroller fo VBAT
Auxiliary Output
\_  AUX (J24)
12-24v output Q or
Lamp Relay
>< PTO Switch Input
\ PTO (J26)
Slow Blow Fuse “Hi]ﬁ —  Switched
Ao [ to VBAT
Power (DG) VvBAT J19)  (4amP)
B GND (J1 4) Engine Protection Input
EPSW (J2 9)
. N % Switched to
Twisted Pair Wire
Ground

RPS (J2 1) (not used)

Figure 6. APECS 5000 Wiring Diagram
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Speed Sensor Installation

Guidelines

There are four different speed-sensing devices that can be used with the APECS 5000
system.

e Magnetic pickup

e Spark ignition

e Magneto

e Hall Effect Sensor

Refer to Table 1 / Controller Wiring and Figure 6 / Wiring Diagram for guidance in
selecting the speed sensor suitable for your controller and application.

For magnetic pickups and Hall Effect sensors, the mounting of the sensor unit must be
rigid; excessive vibration can cause erroneous signals and unreliable performance.

Use twisted pair shielded wire for all speed | specs 5000
sensor wiring. Shield should be grounded RPN+ (J1-10)

at the controller only.
RPM—(J1-3)

Figure 7. Speed Sensor Wiring

] [ o s

Speed Sensor Wiring

Magnetic Pickup

Installed opposite an engine driven gear such as the
flywheel, it transmits a signal each time the magnetic
flux path across the pole is interrupted by a gear tooth.

Connect Pin (J1-10) to the positive and Pin (J1-3) to

the negative side of the sensor. Most sensors do not

have a positive or negative side and can be connected -
either way.

Spark Ignition

Intended for either traditional coil and distributor ignition or
distributorless ignition systems.

Traditional coil and distributor ignition; 2-, 3-, 4-, 6- and
8-cylinder engines: Connect Pin (J1-10) to the negative side of one
coil primary.

Distributorless ignition, 2-, 4-, 6- and 8-cylinder engines:
Connect Pin (J1-10) to the negative side of one coil primary.

May not work with ignition systems that vary the coil charging voltage (e.g., Ford TFI).

Woodward 13
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Magneto Ignition
Typically found on small 1- and 2-cylinder engines.

Connect Pin (J1-10) to the primary/engine kill wire and

Pin (J1-3) to the engine block. On multi-cylinder engines,

confirm that there are no diodes between the primary
connection and J1-10.

Hall Effect

\ ([\.| Located next to an engine driven gear
\j\,\ / g g
f’ ' N Connect Pin (J1-10) to the sensor output and Pin (J1-3) to the negative

side of the sensor. The third sensor lead should be connected to
battery positive (J1-9).

NOTE

@ It is beyond the scope of this manual to discuss detailed speed sensor
selection and installation for all possible applications. Please contact
the factory for specific information concerning your application.

Actuator & Linkage Installation

1. The stepper motor actuator may be attached to the throttle either by means of a
shaft coupling, or by means of a lever and link. A coupling should be tolerant of
misalignments in shaft angle and shaft offset.

2. Select or design a bracket that correctly aligns the actuator shaft and throttle
shaft. The bracket must be able to withstand the vibration level of the engine or
application. The actuator is provided with slots suitable for use with metric
M3 x .5 hex nuts

3. The linkage must have minimal friction, binding and backlash. The bracket and
linkage should be designed to use as much of the actuator travel as possible.
This improves angular resolution and reduces torque on the actuator.

4. Fasten actuator to bracket and bracket to engine. Attach necessary linkage
between actuator shaft and fuel control lever. Move linkage end-to-end to
confirm correct travel.

5. Connect actuator wires (use twisted pair with more than 1 twist per inch).
Connect terminals SP1A and SP1B to stepper phase 1 (terminals A and C on
the stepper motor enclosure). Connect terminals SP2A and SP2B to stepper

phase 2 (terminals B and D on the stepper

motor enclosure). Stepper motor phases APECS 50007207 A

can also be identified using an chmmeter. >< b D RreR
Wiring a phase backwards will reverse the SP1B (J1-6) c 8 PHASE1
direction of rotation, but that can be SP2A (J1-8) B

corrected during calibration. The mating d srerrer
connector for the stepper motor is Delphi >< >< & motor

P/N 12162188-B, which requires four SP1B (J1-7) p OJPHASE2
terminals (Delphi P/N 12124075).

FIGURE 8 Stepper Motor Wiring
6. Actuator travel and direction should be adjusted to assure both maximum (start
fuel or rated load) and minimum (shutdown or idle) positions.
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NOTE

It is beyond the scope of this manual to discuss detailed actuator
selection and installation procedures for all possible applications.
Please contact the factory for specific information concerning your
application.

Engine Speed Setpoint Wiring—Analog Input

The APECS 5000 controller features an analog speed input for mobile or stationary
applications. To incorporate this feature, wire the analog input to an external pot (which
must be connected to a pedal). Use Figures 9 & 10 as a guide to wire the input to your
application. Potentiometer resistances of 3K—-5KQ are recommended.

Once the analog speed input is wired, refer to the APECS Calibration section to
configure the appropriate parameters.

If use of an idle verification switch (IVS) is desired, hook up Pin (J2-5) from the
controller to the idle verification switch on the pedal. (Refer to the manufacturer’s
instructions or OEM manual.) The other side of the switch should be connected to
battery voltage (see Figure 10).

During engine operation, if the IVS switch and pedal pot do not agree, the engine will
operate at minimum speed only.

Non-potentiometric analog voltages may also be used to command set speed. The
analog voltage (0-5 volt max.) should be wired across terminals J2-12 (positive) and
J1-4 (ground).

APECS 5000

VREF (J2-11)

APP (J2-12)

SRTN (J2-2)

Figure 9. Analog Input Switch

APECS 5000 | WREF (2113

APP (2127

SRTH (J2-2) Vol

Figure 10. Analog Input Switch with IVS Wiring
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Engine Speed Setpoint Wiring—Switched Inputs

The APECS 5000 controller has two switched speed inputs for multiple speed settings.
This is convenient for customers who need more than one speed for engine governing
(i.e., idle speed/power speed setting or low power/high power setting).

To incorporate these switched inputs, determine the speed mode desired based on
your application. The five modes available are Single Speed, Two Speed, Three Speed,
Four Speed, or Variable Speed.

After determining the speed mode, select the switch hardware best suited for your
application. (Switch hardware is not provided or sold by Woodward.)

Choose a switch designed for low currents (5 to 20 mA). Avoid choosing
higher current devices that rely on the current to clean the switch con-
tacts. A dry circuit switch is recommended.

The speed select switch is typically mounted on the control panel but can
be mounted in any other suitable location.

Use the accompanying diagrams as a guide for wiring the selected switch to your
controller.

Once the speed select switch is wired, you need to calibrate “Engine Set Speed
Calibration” parameters to make the feature work. Please refer to APECS Calibration
section to configure the appropriate parameters according to the selected speed mode.

Vbatt +

APECS 5000

Speed Select 1

Speed Select 2

(J1-9)

(J2-7)

(J2-8)

(J1-4)
(=

No Connections

No Connections

A toggle switch is used to select
between two set speeds.

TWO SPEED MODE

SINGLE SPEED MODE

No switch is needed.

4

APECS 5000

Speed Select 1

Speed Select 2

Vbatt +
T 1 le Vbatt +
(J1-9) o |
5 2
(J2-7) o <_+__J
| (2-8) No Connections
(1-4)
[
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=

Vbatt 4
1 To Vbatt +
APECS 5000 (1-9) 0
J2-7 2
Spesd Select 1 il /——J
J2-8
Speed Select 2 ¢ J M
(J1-4) 3

1

THREE SPEED MODE

A three position rotary switch is used
to select among three set speeds.

FOUR SPEED MODE

A 4-position rotary switch with two diodes
is used to select among four set speeds.

Typical diodes that can be used with
the four speed mode are 1N4001,
1N4002, up to 1N4007.

Vbatt 4
To Vbatt +
(1-9) !
APECS 5000 O
({2-7) 2
Speed Select 1 & = ‘
opeed selec (12-8) \FfJ
Speed Select 2
3
x &
P
(J1-4)

VARIABLE SPEED MODE

P
i % A momentary switch is used to
ramp desired engine speed either
. To Vbatt +
APECS 5000 |L&19 up or down.
w2ry P '
Speed Select 1 O Jl
Speed Select 2 | (J2-8)
———0
(J1-4) Down

PTO Switch Wiring

The APECS 5000 controller offers a Power Take-off (PTO) feature that allows the

controller to switch from pedal input to switched inputs for mobile applications.

Alternately, the PTO input may be
configured for the autocrank feature.

To use the PTO input, wire a switch to Pin
(J2-6) on the controller. Once the input is
wired, refer to APECS Calibration section
to configure the appropriate parameters.

The PTO input is switched to Vbat.

Vbatt +

APECS 5000

PTO (J2-6) F

17
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Auxiliary Output Wiring

Because a stepper motor will not automatically return to the closed throttle
position in the event of a fault condition or loss of power, it is strongly
recommended that the auxiliary output be configured for diagnostic shutdown
to assure that the engine will shut down in the event of a fault condition.

A lamp or relay can be wired to the auxiliary output on the controller for a variety of
purposes:

1
2

(1) to flash faults

(2)

(3) to indicate diagnostic shut down
(4)

%)

to indicate overspeed condition

4) to indicate PTO engaged

5) for autocrank output

Depending on your application, wire the lamp or relay according to the manufacturer’s
specification. Once the output is wired, refer to the APECS Calibration section to
configure the appropriate parameters.

NOTE: If the output draws more than 200 mA, the output will be disabled and a
fault code will flash.

APECS 5000 Vbott+

Lamp

AUX (J2-4)
or
AUX 2 (J2-3)

Low Side Driver

Figure 11. Typical Lamp Wiring

Vbatt+
APECS 5000 I

__T_‘{

U0

AUX (J2-4)
or

AUX 2 (J2-3) T RELAY

Low Side Driver

Figure 12. Typical Relay Wiring
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Autocrank Wiring

APECS 5000

PTO (J2-6)
Auto Start Switch

AUX (J2-4) 57 E(ﬁ

or
A CRANK MOTOR

Low Side Driver

RELAY

The APECS 5000 offers an autocrank feature for
remote or automatic starting of certain engines

and applications.

Wire the crank motor relay on the engine to the
controller auxiliary output (low side driver). Wire

the auto-start (rocker/toggle) switch to the

controller PTO input (switch to Vbat).

The diagram at left shows how to wire the
autocrank feature. Once the input is wired, refer to APECS Calibration section to

configure the appropriate parameters.

NOTE

When the autocrank feature is used, the PTO switch input cannot be

used for other features.

é WARNING

If using the autocrank feature, make sure you calibrate the controller

for the autocrank feature prior to hook up. If controller is not calibrated

for autocrank and the crank motor relay is hooked up, the engine may
start as soon as power is applied to the controller. (Refer to the
autocrank calibration section in Chapter 4.)

Engine Protection Input Wiring

Optional Feature

The APECS 5000 controller offers an engine protection shutdown feature to safeguard
against adverse operating conditions such as low oil pressure or high coolant
temperature.

The engine protection (EP) input is a switched input similar to the set speed inputs. This
input must switch to ground potential.

Figure 13 shows how to wire the EP input. To use more than one sensor, simply wire
the sensors in parallel as shown in Figure 14. Once the input is wired, refer to the
APECS Calibration section to configure the appropriate parameters.

APECS 5000

AUX (J2-4)
or
AUX 2 (J2-3)

Lamp

Vbatt+

Low Side Driv

er

Figure 13. EP Input/Single Sensor

APECS 5000

AUX (J2-4)
or
AUX 2 (J2-3)

Vbatt+

L

o

T

RELAY

Low Side Driver

Figure 14. EP Input/Multiple Sensor

Woodward
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Chapter 3.
ACT Operation

]
ACT Installation

ACT Kit Contents

The All-purpose Calibration Tool (ACT) is used for programming (configuring and
adjusting) and monitoring the APECS controller with your personal computer. The ACT
kit contains the following:

e Software CD-ROM

e Interface module

e RS-232 connecting cable

e (CD-ROM Installation Guide

Set-up Requirements
Hardware Requirements

e IBM compatible personal computer equipped with a CD-ROM drive and a serial
port with DB-9 connector, capable of 9600 baud communication

¢ Windows software: 95/98/Me/2000/XP

e 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of
free disk space

e SVGA capable video card and monitor, capable of 256 colors and 800 x 600
display
Software Requirements

CD-ROM of calibration tool software to run on your personal computer.
(CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the APECS 5000 unit a standard RS-232 nine-pin cable and a
proprietary interface module is required. Both are included in the ACT Kkit.

NOTE
Make sure power to the PC and the APECS unit is off when making connections.
The engine may or may not be running.

Connect one end of the RS-232 cable to your PC’'s COM port. Connect the other end of
the cable to the interface module.

Now connect the interface module to the APECS 5000 unit via the connector on the
harness. The interface harness is inserted between the J1 (Grey) connector of the
controller and the mating connector in the user’s wiring harness.
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OEM

AUYVMaAooMm
g

OEM

A

APECS 5000 CONTROLLER ACT HARNESS

COMPUTER

INTERFACE ﬂ
MODULE
RS-232 CABLE

Figure 15. ACT System Set-Up

Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM
supplied with the kit. To install the software on your hard drive, follow the procedures
below.

NOTE
Make sure power to the PC and the APECS unit is off when making
connections. The engine may or may not be running.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The
install program should automatically launch. If it does not, open Windows
Explorer, go to the CD-ROM drive and double click on the install program.

2. Follow the prompts from the install program. You may select the default
directory or specify your own.

3. When installation is complete, you may access the ACT software from the Start
Menu or create your own shortcut.

4. The set-up is now complete and you are ready to run ACT.

e Torunthe ACT software, please refer to “Running the ACT Software”
below.

e Put the original CD-ROM in a safe place in case the files on your hard
drive are damaged or lost.

Woodward 21



APECS 5000° Electronic Engine Speed Governing System Manual SE-4096

Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

License Agreement

I

1. Make certain that the APECS
controller is powered up and

Coppright (C1 2004 W oodard. Inc.

connected to the computer's COM
port.

If an icon for the calibration tool
exists, double click on it to start the
ACT software. The license screen

Thiz scitware and the sccompanying wiitten matenal: sre copyighted.
This scitware: may ol be copied, in whols or i pat

regaidless of the foim of medis. wilhout pioe

wiitten consent of Woodward, Ine

‘Woodward, Inc, makes no wananties, express

or impiied, with respect to the software, o its quaty,
performance, merchantabilty. o fitness for anp particulse
purpose, The software is boensed and delfvered Vas-is”

Any damages. loss of propeity, of other costs resuliing
from the us= of this soitware iz the sole respansibiity

of the individual or arganization using i.

will be displayed when the ACT is
launched. You must either accept
the terms or Cancel, which exits the
application.

[0 Tecepiithe tame of the sgesnient |

3. If noicon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it. Default is Woodward, then select “APECS-EPS
Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port
assignment, if needed.
Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming
communication procedures. It will close automatically when the procedure is complete.

Reading Calibration Y alues from controller. Please wait,

RESET_SPEED 2

.

Moving Around the Software

There are five main menu items available with ACT. Several options are available under
each main menu item. The discussion in the following pages assumes the cursor is at
the main menu screen.

e Use mouse to select or move around the menu.
e Use left mouse to execute a command or accept a condition.
e Use function key <F1> for HELP.

e A HOT key (highlighted character in a menu item) can also be used to access
or activate a menu or sub-menu, e.g. File use <ALT> <F>.

e Click on the [x] box in the upper right hand corner to exit ACT.
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ACT Menus & Options
ACT Menu Structure

The ACT has five main menus: File Menu, Calibrate Menu, Monitor Menu, Configure
Menu, and Help Menu with several options available under each. A complete discussion
of all ACT menus and options is presented in the following pages.

Save APECS Cal to File
View CAL File Comments

View Text File
Convert APECS Cal to Text
Convert Cal File to Text

FILE MENU

Convert Cal File to Strategy

Change APECS Calibration
Download Cal File to APECS
CALIBRATE MENU Compare APECS Cal to File Call
Change APECS Password
APECS Calibration Wizard

Parameter View

Parameter Plot

MONITOR MENU Display Faults
Control Strategy

Parameter List

CONFIGURE MENU Configure Serial Port
Help Topics
HELP MENU About ACT

User Manuals

File Menu
Purpose

The File Menu allows you to perform operations related to viewing, saving and
converting files. The following commands are available under the File Menu.

e Save APECS Cal to File

e View Cal File Comments

e View Text File

e Convert APECS Cal to Text

e Convert Cal File to Text

e Convert Cal File to Strategy
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Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file. The
ACT uploads the calibration set from the APECS controller and saves it to a computer
file. This operation is usually done after the controller has been calibrated for satisfactory
engine performance but can also be done at any other time. The data is saved in a
binary file format that is not readable.

To Save APECS Cal to File:

ACT

1. Choose File > Save APECS Cal to File.

ACT will prompt the path where the file will be saved:

2. Enter a file name to save the

calibration data to.

ACT will automatically append
the file extension .ACT to the
file name if you do not specify

one. Click Save or press
<Enter>.

ACT will then read all
of the current cali-
bration values from
the controller. This
screen shows the
progress.

ki

\__? (j Do you wish bo edit the new Cal File Comments?

3.

If you click Yes, the comment editor

screen will appear.

To enter comments, type them one at a
time and press <Enter> or click Save
Edit. You can re-edit comments by
clicking them, changing the text on the

top line and clicking Save Edit.

Save n: | L ACT | &« @ ek E-

File name: |My Cal File] Save I

Save a3 lvpe: IEAL Files [*ACT] j Cancel |
4

Procesting Calibration Yalues

SET_SPEED_4

|

Once all the values are read, ACT
will prompt you to add comments to
the ACT file to aid in later
identification.

Comments Can be deleted by ClICkIng Delete Add s Hew Save Edit EanceIEdnl
on them and then clicking “Delete” or by ot |

pressing <Del>.
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4. Click OK on the comment editor or press <Enter> twice to save comments.

NOTE

The “Save APECS Cal to File” command stores the calibration data as an .ACT file

Click Cancel or press <Esc> twice to close the window without saving
comments. The Cal File will still be created if the comment editor is canceled.

The following message is displayed when the file is created successfully.

-
@ CWoodward ACT ToolhCal tool skuff 1,ACT Created Successfully

The file name in this message is the file selected in Step 2. ACT will save the
calibration data to the designated file and display “Calibration Data Saved in
File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

that cannot be viewed or printed directly. Viewing and printing must be done
from a converted text file. See Convert APECS Cal to Text and Convert Cal File to
Text commands.

View Cal File Comments

This command allows you to display the comments that are attached to a calibration
file. Users add comments when saving a calibration file. The comments help in tracking
specific engine, application, and environment data for which the calibration file was

created.
To View Calibration Comments:

1.

Select a Calibration file and its comments are d

B =

2l

Loak jn: I :gj Dresktop

Choose File > View Cal File
Comments.

“SMy Documents

L My Computer

28 My Metwork Places
CAD System Files

ACT will display a list of files on the left
side of the screen with file comments
on the right:

Use the Up and Down arrow keys to
highlight the desired calibration file
(.ACT extension) and view the
comments attached to that file.

Click OK or Cancel to close Comment
Viewer. The comments are created or
edited when the files are created.

s8] DEMO 000
L 1EF PdF's

File hame: |

j Close

Files of tpe:  [Cal Files(* 000 ACT)

™ Open as read-only

Calibration File Comments

Woodward
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View Text File
This command is a convenient way to view text files.

1. Choose File = View Text File.

ACT will prompt for a text file to view.

2. Select a file and click OK.

ACT will open the selected file with the default viewer for that file type.

Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration
data as an .ACT file that cannot be viewed or printed directly. Viewing and printing
must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to Text”
and “Convert Cal File to Text.” The difference between the two commands is as
follows:

1. In“Convert APECS Cal to Text” operation, the calibration set that is converted
is from the APECS unit.

2. In*“Convert Cal File to Text” operation, the calibration set that is converted is
from a previously saved file.

You may use the View Text File command to view text files.

Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for viewing or
printing from any text editor utility in Windows. A printed copy of the calibration data can
be useful for future reference.

To Convert APECS Calibration to Text:
1. Choose File > Convert APECS Cal to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.

ACT will read all of the calibration values from the controller, create and save
a text file with the parameter names, values, and units, then display the file
using the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text
file for viewing or printing from any text editor utility in Windows. A printed copy of the
calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File > Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.
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ACT will read all of the calibration values from the controller, create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a
different control strategy version.

ACT will:
1. Parse through all of the calibration parameters in the old ACT file.

2. Search for the same calibration parameters in the new ACT file and assign
values from the old calibration.

To Convert a Cal File to a New Strategy:

1. Choose File > Convert Cal File to Strategy.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click
OK.

ACT will read all of the calibration values from the controller create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS calibration. The
following commands are available:

e Change APECS Calibration*

¢ Download Cal File to APECS*

e Compare APECS Cal to File Cal
e Change APECS Password*

e APECS Calibration Wizard*

(") These commands can be password protected to prevent unauthorized calibration
changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure and
adjust) various parameters associated with the APECS controller.

APECS 5000 is a programmable engine governor. Changing APECS calibration
parameters is the means to configure the APECS controller for specific engines,
applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your convenience.
Browse through the categories to view the specific parameter you want to change or
adjust.

Some parameters must be set before the engine can run. Other parameters can be
adjusted while the engine is running. See “List of Parameters” in Chapter 4.
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All adjustments are stored immediately in non-volatile memory in the APECS unit. The
APECS controller will retain the changes even if power is lost or the ACT is disconnected.

To Change APECS Calibration Parameters:
1. Choose Calibrate > Change APECS Calibration.
Set the “View Filter” to select a group of parameters.

Use F5/F6 to scroll through the list.

A w0 D

To change the highlighted parameter:
Enter the new value in the “New Value” field
Press <Enter>
The new value is written to the controller and then read back, with
the result placed in the “APECS Value” field.

5. Press <Esc> to exit.

Download Cal File to APECS

The “Download Cal File to APECS” command allows you to download the entire
calibration set from a file to the APECS permanent memory. This is a convenient one-
step method for:

e Reverting back to a known good calibration set after experimenting
with new calibration settings

e Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for
satisfactory engine performance with another APECS unit.

To Download a Cal File to APECS:

i
1. Choose Calibrate > Download Lock [ ] Desion ERS =t

Cal File to APECS. The following
screen allows you to select a Cal
file to download.

Fiepame: | = |
Files of type: [ Cal Filesl~ 000~ ACT) | Cancel
™ Dpen as ead-only
Caibrafion File Comments:
Z
2. Choose a flle and Processing Calibration Yalues
click OK. The fol-
lowing screen will OVERSPEED. APM
show the progress.
,7
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3. The following screen is shown when the operation is complete.
ACT x|

L "_n. The calibration file was downloaded successFully.
[

NOTE: During the “Download Cal File to APECS” operation, the user may
encounter a situation where the Cal File password is different from that of the
APECS unit. If this happens, please refer to the steps below to complete the
download operation.

To Download a Cal File to APECS with a Password Different from that of the
APECS Unit:

Whenever the APECS password is added or changed, the new password is stored in
the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the
calibration file matches the password in the unit, ACT will readily download the
calibration to the APECS unit.

However, if the password stored in the calibration file does not match the password in
the APECS unit, ACT will alert you of a password mismatch. Please follow the steps
below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File
password differs from that of the APECS unit. Download the Cal File password
to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will be
downloaded and the password in the APECS unit will be changed to match the
password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded but
the password in the unit will remain unchanged.

NOTE

@ Before answering Yes to the message, make sure you know the password in
the calibration file. If you do not know the password, you will not be able to
access the password-protected features under the Calibrate menu.

Please see “Change APECS Password” command for more information on password
protection.
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Compare APECS Cal to File Cal

This command lets you check the differences in calibration sets between a saved file
and the APECS unit. The feature is useful, for example, to ensure that the saved file
matches the calibration in the APECS unit.

To Compare APECS Cal to File Cal:

Choose a Calibration file to compare 21l
Look jn; | 5] Desktop =l + B e B

Z30y Documents

1. Choose File > Compare APECS

Cal to File Cal. This screen allows
you to select a Cal File to com-

Sty Computer

452 My Network Places
[2CAD System Files
] cemo.000

[+ |EF Pdf's

pare.

File name: ]

Open I
| Cancel

Files of type: IEaI Files(* 000" ACT)

I~ Open asreadorly

Calibration File Canments:

2. Choose a file and Click OK. This
screen will show the progress.

Processing Calibration Yalues

OVERSPEED_RPM

—

3. Once all parameters have been processed, a CT x|
message box will list the compare results. If the
parameters in the file match the controller, the & File Matches Controller
following message box appears:

4. Click OK to close. If there were mismatches, the following message will appear:

Compare Differences x|

Controller <> C:“WOODWARD~ACT TOOLAFXA1MOSTEST ACT Hismatch List
Hane File Controller Units
ACTUATOR FDBK_GAIN 0.20001 0.72438 NONE
ACT_FDBK_KFILT 0.801 0977 NONE
AFE_LOST_DLY 21 20 ns*10
AFB_NO_AMPS 33000 0 ma
APP_AD ORH 254 1023 adeats
APE_AD ORL 10 0 adcnts
APE_FULL_DEADEAND 3 5 adonts
APE_IDLE_DEADBAND 6 5 adcats
APP_MIN CAL 230.0 240.5 adcuts
APP_NOISE CNT 31 30 NONE
APE_RANGE _CAL 5500 540°5 adonts
AUTGCRANK_CRANK_TIME 110 10.0 sec
AUTOCRANK MAX TRIES 5 & HONE
AUTOCRANK_NS_TIME 1.0 1.5 sec
AUTOCRANK_REST_TIHE 16.0 15.0 sec
AUXILTARY OUTEUT_J_WMODE 1 0 NONE
AUXILIARY OUTPUT_MODE 2 0 HONE
AUL I LIH 121 120 a2d
AUZ_LAMF_INRUSH TIME 4 3 nsecx10
AUX_QUTEUT_2_RFH 1500.0 700.0 zpn
AUL_OUTEUT_RPY 1501.0 700.0 zpn
BRAKE DELAV 1 0.0 sec
RANK_2 | 1100.0 700.0 rpm
CRANK_DUTY_CVCLE 1.000 0.945 %100
DERIVATIVE GAIN 0262 0.250 HONE
DERIVATIVE GAIN IDLE 0.262 0.250 HOWE

|1l v

Cos | |00

You may select "Save to File" if you would like to save a permanent record of
the file compare. You will then be asked to select a destination directory and file
name.
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Change APECS Password

This command allows you to add or change a password to protect certain calibration
features. The option is useful, for example, to prevent unauthorized changes to a known
good calibration set in the APECS unit.

By default, the APECS unit is not password protected.

x
To Change APECS Password: = =

1. Choose Calibrate > Change APECS =
Password. YOU W|” be prompted for the Flease enter the controller password:l |

current password.

Change I Cancel I Ok I

IEnter password and click OF.

Status:

2. The application will

query the controller to

verify that the entered

password matCheS the Flease enter the controller password:l

current password. If the

password matches, the

“Change” button is S Change | Cancel [[ ok |

enabled: IPassword Walid. Click 'Change’ to chahge contraller passwaord

3. Click “Change” and the application will prompt for the new password:
x

Enter new Password: I

Change I Cancel | QK |
Status:

IPassword Change Mode.

4. Enter the new password. It should be one word, no spaces, and up to 11
characters long. Once entered, click OK. The application will prompt to
reenter the password to make sure that it was typed in properly:

5. Re-enter the password and click =
OK. If the two entries of the new
password are equal, the new
password will be encoded and Re-enternew passworc |
saved in the controller.

Passwords are upper and lower case i Chenge |  Carcel [[ 0k |
Sensitive. IPassword Change Mode.

After changing your password, please record it in a safe place for future reference.
To revert to no password protection, change APECS password to “peg,” which is the
default password.
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ACT Operation with the New Password:

Once a password is added or changed, the following calibration features become
password protected:

Change APECS Calibration
Download Cal File to APECS
Change APECS Password
APECS Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new
password to gain access to these features. You only need to enter the password once
during any session to gain access to all password-protected features.

APECS Calibration Wizard

The APECS Calibration Wizard is an interactive guide to help you get your controller
unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the APECS Calibration Wizard:

1. Choose Calibrate > Calibration Wizard.

2. The Wizard will give you the option to use the default calibration or modify the
existing one. If you select the default calibration, the Wizard will reset all
calibration parameters.

3. Press <Enter> to continue or <Esc> to abort the Wizard.

If you press <Enter> the Wizard will lead you through the calibration
process with a series of questions. When all questions have been an-
swered the Wizard will ask you to confirm that the values entered are
accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the
values, or <Esc> to abort the Wizard.

If you press <Enter>, the APECS Wizard will download the new calibration and
reset all APECS parameters. This will complete the APECS Wizard operation.

NOTE: The APECS Calibration Wizard only covers basic calibration. It
does not automatically assure optimum engine operation. Please refer to
APECS Calibration Procedures for more information.

5. You are now ready to run your engine. Press any key to go directly to the
Parameter Plot screen where you can adjust the PID gains.
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Monitor Menu

The Monitor Menu allows you to observe engine and APECS operation in real time. The
following commands are available under the Monitor Menu.

e Parameter View
e Parameter Plot
e Display Faults

e Control Strategy
e Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed) inreal
time.

To View Parameter Values in Real Time:

1. Choose Monitor -> Parameter
View. The application will P — Tl i |
launch the view screen. [ B B

2. The screen automatically Confgre

starts reading values from the
controller and displaying the
values

3. To stop the updating, click on
Stop. The button name will
then change to ‘Start.” Clicking it again will start updating again.

NOTE

If any other screen is opened that requires communication with the
controller while the screen is updating, the Parameter View screen
will be automatically stopped.

Parameter Plot

I Parameter Plot E

The Parameter Plot command lets you
view engine performance on screen in
the form of a real-time graph. This
feature allows you to perturb the system
and observe the response to fine tune
engine performance.

To View Parameter Plot in Real Time:

Select Monitor > Parameter Plot. The
application will launch and start the
parameter plot view.

. ) ) . e EHDPURHDNAL_BAW"EDBD_‘ enging_tpm [rpm] 'W
The application will read the previously Coigee | WTESRALGAN [ dededlon) ZE

saved configuration and request the Sgeofle | DENATMESAN i

controller to start sending the parameter

values. The controller sends the data to the PC at a rate that varies with the number of
parameters being monitored. The application uses the Windows timer functionality to
update the screen at the specified rate. Note that if the PC is very busy, the timer
accuracy will vary, therefore, the screen and generated data files should be considered
as reference only.
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The X-axis time scale (25 seconds in the example screen) may be shorter than
configured due to the resolution of the monitor. This value will be adjusted when the
graph is resized. This also applies to the print functionality for this screen. All of the data
will be recorded in a revolving buffer for use by the “Save to File” feature (see below).

The axis scales, parameter names, update resolution and time scale on the Parameter
Plot may be changed as described in the Plot Setup screen.

PID Gain Adjustments from Plot Display Screen

After initial calibration, most engines require only a minor adjustment to PID gains to
fine tune the system to its optimum level. ACT provides a convenient means of
adjusting the PID gains directly from the Plot Display screen.

To Make PID Gain Adjustments from Plot Display Screen:

1. Press the letter <P> for proportional, <I> for integral, or <D> for
derivative gain adjustment. The application will enable the gain you
selected.

2. Use the Up or Down arrow keys to increase or decrease the present
value. The arrow keys adjust the values by 0.004. New values may be
typed in directly. Hit <Enter> after you type in a value. The application
will save the new value in the APECS unit.

3. Press the <Esc> to deselect the gain adjustments.

To Change Plot Setup:

This allows you to choose engine rpm, desired engine speed, duty cycle or any other
parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit
the parameter and/or speed

1. On the Parameter Plot screen, click on “Configure.” The application will show
the following screen with the current values.

x
Flat 2
j In_des_sw_new d
Az Max I‘I 0 Auis Max |-5
Axiz Min ID Auis Min I'-‘I
¥ Aiz Time Scale |60 [zec) * Awiz Sample Rate |100 [m-zec)
Cancel | 0K I

Plot 1/ Plot 2
Use the pull-down to select the desired parameter to plot.
Axis Min / Max

Enter the minimum / maximum value for the parameter value.

X Axis Time Scale
Controls how much data is displayed on the X axis. This value may
automatically adjust for screen resolution.

X Axis Sample Rate
Controls how often the data from the controller is used to update the
screen. Data received between timer ticks is discarded.
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2. Clicking OK will save this information in the Windows Registry so that
it will be remembered the next time the program is started.

NOTE: The Calibration Wizard will automatically set up the
plots if there are no saved defaults.

Display Faults

This command allows you to display present faults in real-time. This means if new faults
occur while you are monitoring, the screen will automatically update to display the
current faults. The display will also show historical fault codes that have been previously
logged but do not currently exist. Historical fault codes are helpful when tracking down
intermittent faults.

To Display Faults in Real Time:

- Cunert Fauls:

Stat [
1. Choose Monitor - Display G |
Faults from the main menu. P
The application will launch the
Fault view.

- Histarical

Updste Historical Fauts | [ Source [ Histoical Enor Descripicn [
. . . No Historical Faults:
The application will update the o i Pl

display every time the
controller sends the fault_flags
status. This happens several
times a second.

2. Click on the “Pause” button to stop the automatic update of this screen. The
text on the button will change to “Start” and clicking it again will re-start the
automatic updating.

NOTE: If any other screen requests data from the controller while this
screen is updating, this screen will automatically Pause.

Control Strategy

This command allows you to check the version of the control strategy in use. This
information may be needed for strategy identification purposes and for future updates.

Parameter List

The Parameter List screen allows the SR
user to adjust which parameters are Caaens [Fomi [
displayed on the Parameter View r—
. O View List
isplay.
d Sp ay lcjga,luad‘,cnu Wiew Position
eep!um:v‘v':t?ar_anempls
To Display the Parameter List: ey
| Eh
1. Choose Monitor > Parameter g
. . £ps_span_chtr
List from the main menu. v
=y
lamp_flash_cnitr
2. The F5/F6 keys will L [ o e ]
backup/advance through the "[lFE]PHEV\EIUS [FEINEXT  [F9]ADD/REMOVE OM VIEWS [ESE]EANII:ELEDITIELEISE }v/

list. Press F9 or click on “On
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View List” to toggle the selected parameter on the Parameter View screen.

3. Click on the ‘x’ in the title bar or press <Esc> to close the screen. Edits are not
saved between application launches.

4. If the Parameter View screen is already open when changes are made to
the view list, close the Parameter View screen and re-open it to make the
changes effective.

Save
Clicking Save will prompt the user for a file name to save the currently viewed
configuration to.
Type in a file name that reflects the
2xl purpose of the saved configuration
Savein: | 3 ACT |« Bk E- and click Save. The view configuration

Choose or create a file to save the vig:

[ erigine spesds. vt dialog will now display the selected file
(1= errar codes. avf name in the title bar.
Open

Clicking Open will prompt the user
for a file name of a previously saved
View Configuration.

File naés | MyviewSetur L_s== |  Select the desired file and click
Save as type: [ACT View Setup Files [*.a+) =] Cancel | Open. The View Configuration will be

4 updated with the saved parameters.

The ACT application will always recall the default set of plot configuration parameters at
application startup, and does not recall the last used view setup file. So the view
configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing
the configuration on the parameter list screen (F9 or Open), then opening a new
Parameter View.

NOTE: Only one of the parameter view screens can be monitoring the controller
at once.

Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable
communication between the ACT and the APECS controller.

To Configure the Serial Port: ]
. —Serial Contraller Connection—— — Demo Made
1. From the main menu screen, T A e |

choose Configure > Custom

. . . . " Com2 = APECS 500
Serial Port. The application will o
display the following screen: e Custom | &
¢ APECS 4000
2. Choose a port and Click OK. This " APECS 4500

screen will be displayed on appli-
cation startup if a controller cannot
be found at the last selected port
and can be changed any time after the application has started.

36 Woodward



APECS 5000° Electronic Engine Speed Governing System Manual SE-4096

Demo Mode
This mode will use a calibration file “Demo.000” and use
random numbers for values requested from the controller.

COM 1/COM 2

This mode will look for a controller attached to the selected
serial port. An error message will be displayed AFTER you
click OK if a controller cannot be found or if the port cannot
be opened.

COM ports outside of this range can be used by editing the
default COM port registry key for this application.

Help Menu
The Help Menu provides access to the online user's manual and other information helpful to
your use of the Calibration Tool. The following commands are available under the Help Menu:
e Help Topics
e About ACT
e User's Manual

Help Topics

This command allows you to search for specific information by displaying software menu
items or through key words.

1. Click on “Contents” for an outline of the software applications listed by
menu items.

2. Click on “Index” or “Find” to locate a specific topic through an alphabetical
listing or by typing in a word or phrase.

3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This
information is important for tool identification purposes and for servicing support.

User’s Manual

This command accesses the User’s Manual, which includes comprehensive information on
the APECS 5000 controller, wiring diagrams, ACT software menus, and calibration
parameters. The manual may be viewed online or printed for future reference.
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Chapter 4.

Calibrating APECS Features

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the
various APECS 5000 features to work with your application.

Before proceeding, make sure you have installed all the required hardware for your
system and are familiar with using the APECS All-purpose Calibration Tool (ACT).

Safety Precautions

The APECS 5000 is a user configurable engine speed governor and will follow your
settings and commands immediately. Please be aware of this when calibrating and
entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what the
engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS or the
ACT. Entering values outside of safe operating range can result in serious physical
injury and/or damage to the equipment or application.

WARNING

An overspeed shutdown device, independent of the APECS system, should be
provided to prevent loss of engine control that may cause personal injury or
equipment damage.

Calibration Categories

To incorporate any of the programmable features in your system, a set of parameters
associated with each feature must be calibrated using the calibration tool (ACT). These
parameters are grouped under various categories under the Calibrate Menu in ACT.
(Refer to Table 3 below.)

Table 2. Calibration Categories and Features

CALIBRATION
CATEGORY FEATURES AVAILABLE
Governor Gain PID Gain Settings
Engine Set Speed External Pot Calibration
Speed Input Speed Input Calibration
Engine Start Autocrank
Diagnostics (F?verspfeed/Underspeed
rotection
Actuator Output Stepper motor direction, max
travel and step rate

NOTE: For basic APECS operation to begin, you only need to configure Engine
Set Speed, Speed Input, and Actuator Output parameters. All other parameters
are preset to values that will work with many applications.
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Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 5000
controller.

Before proceeding with calibration, please ensure that the controller unit is connected to
the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.

1. If anicon for the calibration tool exists, double click on it to start the ACT
software.

2. If noicon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it.

3. Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

Follow the procedure outlined in the Configure Menu to change the COM port
assignment, if needed.

4. If you wish to use the Wizard for basic calibration, refer to “APECS Calibration
Wizard.” The Wizard is an interactive guide to help you get your controller
running as quickly as possible.

5. If you do not use the Wizard, pay particular attention to calibrat-
ing the travel (STEP_MAX_STEP) and direction of travel (highest
bit of STEP_CONFIG) of the stepper motor. Every count of
STEP_MAX_STEP equals 1.8°, so a travel of 72° equates to 40
counts. Refer to “Actuator Output Calibration Parameters.”

Also calibrate the speed input for the type of speed sensor,
SPEED_TYPE as well as the appropriate values for PULSES_
PER_REV and PULSES_PER_UPDATE. Refer to “Speed Input
Configuration Parameters.”

6. Beyond basic calibration, there are many parameters associated with APECS
that can help enhance the performance of your engine. Read the section on
“Understanding APECS Calibration Parameters” and decide on the
parameters you would like to adjust.

7. Access “Change APECS Calibration” option from the Calibrate menu and
select the desired parameter from the appropriate category. Adjust the value of
the parameter as needed.

8. Repeat Step 5 until all desired parameters have been adjusted and
satisfactory engine performance has been achieved.

9. You do not need to save the new calibration settings. All settings are
automatically saved in the controller and remain in memory after shutdown.
Saving a Calibration Set to File

After satisfactory engine performance is achieved, it is recommended that you save the
calibration set to a file.

e A saved file allows you to experiment with other calibration settings and
still be able to recall the saved calibration set.

e A saved calibration set can be used for configuring additional APECS units.

To Save a Calibration Set to File:

1. Access the File Menu to activate the “Save APECS Cal to File” command.
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Enter a file name to save the calibration data to a designated file.

When prompted to edit the comment list, enter information that will help you
keep track of specific engine, application and environment data associated
with the file.

4. ACT will save the calibration set and automatically append the file
extension “.ACT” to the file name.

Calibrating an APECS Unit with a Saved Calibration File

You may wish to calibrate additional APECS units with a saved calibration file for
consistent, optimized operation.

To Calibrate an APECS Unit with a Saved Calibration File:

1. Access the Calibrate menu to activate the “Download Cal File to APECS”
command.

2. Select the appropriate file to download (refer to the comment list on the right
side of the screen to help identify the desired file). Enter password if prompted.

ACT will download file calibration to APECS permanent memory.
3. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

NOTE: The APECS unit must be powered up, but need not be mounted on the
engine to carry out the calibration procedure.

Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration
parameters, lists parameters, and provides calibration procedures.

Frequently Asked Questions

What is a calibration parameter?

A parameter is a numerical value that helps the calibrator adjust or set the APECS
controller. Once fixed by a calibrator, the parameter is not subject to change while the
system is operating. APECS calibration parameters are used not only to adjust and set
the controller but also to configure it properly for different applications.

Why do we need to calibrate the APECS system?

APECS 5000 is a software programmable system and has no manual adjustment.
Calibrating is the only means of configuring and adjusting the controller for your specific
application.

Do | need to calibrate ALL the parameters to make my system work?

No. Two parameters, PULSES_PER_UPDATE and PULSES_PER_REV, are factory set to
prevent the APECS unit from calculating an engine speed and driving the actuators.
These two parameters must be calibrated to a non-zero value before normal APECS
operation can begin. Other parameters are preset to values that will work with many
engines and applications. However, it is recommended that you review all settings for
your own application.
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Is it possible to enter values in APECS in excess of what the application is
capable of performing?

Yes. While ACT (the calibration tool) restricts you from entering values outside of the
specified range, the range itself is fairly wide and it is possible to enter values in excess
of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 rpm with ACT. Your
engine may or may not be able to operate at this speed. It is also possible to damage
the generator or pump attached to your engine by commanding maximum engine speed
because while the engine may be capable of performing at the rated rpm, the generator

or pump is likely to have a lower rpm rating than the engine.

Furthermore, there are certain parameters that are used to properly configure an
application. Entering incorrect values for these parameters will result in improper
configuration and may make the engine run at maximum throttle. Entering values
outside of safe operating range can result in serious physical injury and/or damage to

the equipment.

List of Parameters

CATEGORY PARAMETER DESCRIPTION FACTORY
DERIVATIVE_GAIN Speed stability 1
Governor INTEGRAL_GAIN Steady state speed 2
Gain
Calibration PROPORTIONAL_GAIN Transient response 5
MASTER_GAIN Combined PID gain 1
response
Engine Set Delay f
y for return to
Speed BRAKE_DELAY idle, mode 023 15
Calibration
EXTERNAL_ANALOG_MODE External analog 0
input configuration
Engine speed ramp
RAMP_DOWN_RATE down rate 1000
RAMP_UP_RATE Engine speed ramp 1000
up rate
SET_SPEED_1 Engine set speed 1 1800
SET_SPEED_2 Engine set speed 2 1900
SET_SPEED_3 Engine set speed 3 2000
SET_SPEED_4 Engine set speed 4 2500
SET_SPEED_MAX Maximum 2600
increment speed
SET_SPEED_MIN Minimum 1000
decrement speed
SET_SPEED_TRIM Engine trim speed 200
(rpm)
SET_SPEED_WARMUP Engine warm up 1800
speed
Multi-speed
SPEED_DECREASE_DELAY decrease delay 0
time (sec)
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CATEGORY

PARAMETER

DESCRIPTION

FACTORY
CAL

SWITCH_CONFIGURATION

1,2,3,4: multispeed,
5: variable speed

WARM_UP_TIME

Time spent at
warm up speed

Speed Input
Configuration

SPEED_TYPE

Mag pickup = 128
Coil Ignition = 2
Magneto = 3

Hall Effect = 131

128

PULSES_PER_REV

No. of pulses per
engine revolution

PULSES_PER_UPDATE

No. of pulses until
next engine speed
update

Engine Start
Calibration

AUTOCRANK_CRANK_TIME

Time autocrank
holds crank
solenoid on (sec)

AUTOCRANK_MAX_TRIES

Number of
autocrank attempts

AUTOCRANK_REST_TIME

Rest time between
autocrank attempts
(sec)

CRANK_DUTY_CYCLE

Kickoff duty cycle
for open-loop
cranking

0.945

KEY_ON_DUTY_TIME

Time at no-start
and key-on to drive
duty cycle

Diagnostics
Calibration

ENGINE_PROTECT RUN_TIME

Engine run time
before checking
switch

(8000 = disabled)

8000

ENGINE_PROTECT_TIME

Switch delay before
engine protection
shutdown

1000

OVERSPEED_RPM

Actuator shutdown
speed (max)

UNDERSPEED_RPM

Actuator shutdown
speed (min)

UNDERSPEED_RUN_TIME

Run time before
underspeed is
checked

10
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CATEGORY PARAMETER DESCRIPTION FA(é';?RY
Drive aux. output
AUX_OUTPUT_RPM when above this 700
engine rpm
0: status lamp
1: use RPM
2: critical shutdown
AUXILIARY_OUTPUT_MODE 3 PTO 0
4: autocrank
5: mimic LED
DROOP_PERCENT % 0
Desired step posn when
STEP_CAL STEP_MODE=2 0
STEP_CONFIG X0000011, X = direction | 00000011
Actuator
Output
Calibration STEP_MAX_STEP Actuator travgel in steps 40
(1step = 1.8")
0: normal closed-loop
governing
1: step follows analog
STEP_MODE Input 0
2: step_posn =
STEP_CAL
3: sweep mode
STEP_PRD Duration of each step, 3000
usec
STEP_WAIT Delay on stepper 4000
reversal or stop/start
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Calibration Procedures: PID Gains Adjustment

These parameters allow proportional, integral and derivative gains to be programmed
by the user.

Calibration Parameters Needing Configuration:

DERIVATIVE_GAIN
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until response has a
slight overshoot on load transients.

INTEGRAL_GAIN
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until speed
begins to oscillate, and then decrease until oscillation stops. If oscillations do not occur,
bump actuator lever, then decrease integral gain until oscillation stops.

PROPORTIONAL_GAIN
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of proportional
gain should be used while still maintaining stability. Increase proportional gain until
speed begins to oscillate, then decrease until oscillation stops. If oscillations do not
occur, bump actuator lever, then decrease proportional gain until oscillation stops.

MASTER_GAIN
As a multiplier to the PID gains, master gain is used to increase or decrease the
combined derivative, integral, and proportional response with a single gain.

For example, the effective proportional gain used is PROPORTIONAL_GAIN X
MASTER_GAIN. This permits adjusting all three gains with a single calibration
parameter. Range: 0-255. Default value: 1.0.

PID Gain Settings Response Plots

ACT allows the user to adjust the P, |, and D gain settings and observe the response
directly on screen in the form of a real-time plot. The plots on the following page
illustrate the various conditions a user may encounter while tuning an application.
Although conditions may vary according to application and nature of load, these plots
are typical of what is often observed.

Figures 16-20 illustrate less desirable conditions often encountered while tuning an
application and suggest probable causes.

Figure 21 shows a plot of a properly tuned application. Although conditions may vary
according to application and nature of load, this plot is typical of what is often desired.
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NOTE: Excessive friction and slop in the linkage are primary contributors to
poor governor stability. If it is not possible to stabilize engine performance,
check smoothness of the linkage.

Engine Set Speed Calibration Parameters

Calibration Procedures
The APECS 5000 has two primary means of selecting engine speed setpoint:

e Using analog speed setpoint (EXTERNAL_ANALOG_MODE)
e Using switched speed setpoint (SWITCH_CONFIGURATION)

To make the controller suitable for many mobile and stationary applications, there are a
variety of ways the speed switches and the speed pot can be configured (e.g., independently
or together).

Calibration Parameters Needing Configuration:

The two primary parameters are:
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EXTERNAL_ANALOG_MODE

This is the main parameter that defines how the analog APP input is interpreted for
selecting desired engine set speed.

Speed selection may be based on the analog input, the speed select switches, or a
combination of the two. See Table 4, External Analog Input Modes.

SWITCH_CONFIGURATION

This parameter is used to let the software know how the user has configured the speed
switch inputs.

Calibrate SWITCH_CONFIGURATION according to the selected speed mode. There are
five switch configurations available: Single Speed, Two Speed, Three Speed, Four
Speed, and Variable Speed. See Table4, Switch Configuration Modes.

Parameters Used with the Two Primary Parameters:

BRAKE_DELAY
When external analog mode is set to 23, this parameter is used to specify the delay, in
seconds, for automatic return to idle once the IVS input indicates no load on the engine.

Range: 0-31.875 seconds. Once the timer times out, SET_SPEED_MIN will be
commanded, regardless of whether the controller is in pedal mode or PTO mode.

RAMP_DOWN_RATE

Rate at which command engine speed decreases from one set point to a lower set point
(rpm/second)

RAMP_UP_RATE

Rate at which commanded engine speed increases from one set point to a higher set
point (rpm/second)

SET_SPEED _1
Preset engine speed 1 (rpm). Used when SWITCH_CONFIGURATION = 1-4

SET_SPEED_2
Preset engine speed 2 (rpm). Used when SWITCH_CONFIGURATION = 2-4

SET_SPEED_3
Preset engine speed 3 (rpm). Used when SWITCH_CONFIGURATION = 3-4

SET_SPEED_4
Preset engine speed 4 (rpm). Used when SWITCH_CONFIGURATION = 4

SET_SPEED_MAX
Highest engine speed command possible when using push-button switches to ramp
engine speed up (rpm). (SWITCH_CONFIGURATION = 5)

Also used to specify the maximum rpm commanded with an analog input.

SET_SPEED_MIN

Lowest engine speed command possible when using variable speed mode to ramp
engine speed down (rpm). (SWITCH_CONFIGURATION = 5).

Also used to specify the minimum rpm commanded with an analog input.
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SET_SPEED_TRIM
Amount speed may be trimmed with external pot above/below set speed.

SET_SPEED_WARMUP
Engine speed set point used immediately after engine has started running (rpm.)

SPEED_DECREASE_DELAY

When in multi-speed mode 2, 3, or 4 and the speed switch input is changed to select a
lower speed, this is the delay before the engine speed command is ramped to a new
lower speed (seconds).

This is useful for applications that are continuously switched on and off such as welding
machines.

WARMUP_TIME

Length of time to hold engine at warmup speed immediately after engine has started
running (seconds). Setting WARMUP_TIME to zero disables the warmup feature

NOTE: All switch inputs are switched to Vbat.

External Analog Input Calibration (with IVS)

Use the external analog input for a variety of functions such as (1) Pedal position
sensor with idle verification switch, (2) Remote speed adjustments, and (3) Trim
potentiometer. See “Auxiliary Output Wiring” for wiring analog inputs.

Woodward 47



APECS 5000° Electronic Engine Speed Governing System Manual SE-4096

Table 3. External Analog Input Modes

000 No external analog input Use speed switch or momentary switch.

001 Trim mode Use external pot to trim the selected set speed. The
speed selected by the set speed switches is
adjusted by plus or minus SET_SPEED_TRIM. The

101 | Trim mode, reverse pot* set speed is bounded by SET_SPEED_MIN and
SET_SPEED_MAX.

002 | Set speed with pot

. Use external pot to adjust set speed between
012 | Set speed with pot, PTO SET SPEED MINand SET _SPEED_MAX.
available PTO is available where indicated and allows
switching from pot selected speed to switch
102 | Set speed with reverse selected speed. Auxiliary output can be configured
pot to indicate the PTO state.
Ramp rate limits are still in effect.

112 | Set speed with reverse

pot*, PTO available
003 | Drive-by-wire, no IVS
013 | Drive-by-wire, no IVS,
PTO available Use pedal pot to adjust set speed between
SET_SPEED_MIN and SET_SPEED_MAX with
) . additional fault management. Controller must see
103 | Drive-by-wire, IVS open minimum peddle position before command for off-
atidle idle will be accepted.
Can be used with an IVS (idle verification switch).
13 Drl_ve-by-W|re, IVS open PTO is available where indicated and allows
atidle switching from pedal pot selected speed to switch
selected speed. Auxiliary output can be configured

203 | Drive-by-wire, IVS closed | © indicate the PTO state.

atidle Ramp rate limits are still in effect.
213 | Drive-by-wire, IVS closed
atidle, PTO available
. . Uses IVS as brake input—will do automatic return
023 | Drive-by-wire, PTO to idle (SET_SPEED. MIN) when IVS is active for
available, brake mode longer than BRAKE_DELAY seconds. Otherwise,
similar to Mode 013.
255 | APS calibration mode. See | Allows an external pot from various applications to
“External Pot Calibration” interface properly with the controller.

(*) Reverse pot option reverses speed increase/decrease relationship to a clockwise
rotation of pot.
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CAUTION
If a drive-by-wire mode is being used (003, 013, 023, 103, 113, 203, 213) the
engine is not allowed to start up in PTO mode.

PTO is locked out until the engine has started and the PTO switch is
transitioned from its off position.

Switch Configuration Modes

Use the switched inputs and speed setpoint parameters to set up to four discrete
speeds and set ramp rates between speeds OR use the inputs to manually increase or
decrease speed at preset rates with variable speed control. Refer to “Auxiliary Output
Wiring” for wiring switch inputs.

Table 4. Switch Configuration Modes

CONFIGURATION DESCRIPTION
MODE

A single engine speed is commanded.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will increase
from SET_SPEED_MIN to SET_SPEED_WARMUP at the
=1: SINGLE SPEED | RAMP_UP_RATE.

Engine speed remains at the warm up speed for
WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to SET_SPEED_1.

A switch is used to select between two set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will increase
from SET_SPEED_MIN to SET_SPEED_WARMUP at the
RAMP_UP_RATE.

=2: TWO SPEED Engine speed remains at the warm up speed for
WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to the speed selected by the switch
(SET_SPEED_1 or SET_SPEED_2). When the other
speed is selected with the switch, commanded engine
speed is ramped to the new set speed.

A rotary switch is used to select among three set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will increase
from SET_SPEED_MIN to SET_SPEED_WARMUP at the
RAMP_UP_RATE.

= 3: THREE SPEED Engine speed remains at the warm up speed for
WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to the speed selected by the rotary
switch (SET_SPEED_1 to SET_SPEED_3). When another
speed is selected with the switch, the commanded engine
speed is ramped to the new set speed.
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CONFIGURATION DESCRIPTION
MODE

A rotary switch with two diodes is used to select among 4
set speeds.

The engine is started and transitions from crank mode to
run mode. The commanded engine speed will increase
from SET_SPEED_MIN to SET_SPEED_WARMUP at the
RAMP_UP_RATE.

= 4: FOUR SPEED Engine speed remains at the warm up speed for

WARMUP_TIME seconds, after which the engine speed
either increases at RAMP_UP_RATE or decreases at
RAMP_DOWN_RATE to the speed selected by the rotary
switch (SET_SPEED_1 to SET_SPEED_4). When another
speed is selected with the switches, the commanded
engine speed is ramped to the new set speed.

A momentary switch is used to ramp desired engine speed
either up or down.

The engine is started and transitions from crank mode to

run mode. The commanded engine speed will increase

from SET_SPEED_MIN to SET_SPEED_WARMUP at the

RAMP_UP_RATE. Engine speed remains at the warm up

speed for WARMUP_TIME seconds, after which the user

= 5: VARIABLE may select a new speed by using the switches, which will
) SPEED either increase or decrease engine speed.

A brief pressing of the switch will change engine speed by
one rpm. Holding the switch closed longer will ramp the
engine speed command, first at a slow rate, then at either
RAMP_UP_RATE or RAMP_DOWN_RATE, depending on
which direction the switch is being pressed. The engine
speed command will never ramp above SET_SPEED_MAX
or below SET_SPEED_MIN.

External Pot Calibration

This feature allows an external pot from a variety of applications to interface properly
with the APECS 5000. Refer to Table 4 for mode configurations and descriptions.

Calibration Parameters Needing Configuration:

EXTERNAL_ANALOG_MODE
Allows the external analog input to be configured in a variety of ways.

Calibration Procedures

The calibration procedure is automatic. Simply set the parameter EXTERNAL_
ANALOG_MODE to 255 (refer to Table 4 ) and run the external pot or pedal up and
down through its full range of travel. The controller will automatically learn and store
the minimum and range values in its memory. Set EXTERNAL_ANALOG_MODE back
to the desired speed mode when finished.
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PTO Input

This feature allows selection between pedal input and speed switches in mobile applications.
Calibration Parameters Needing Configuration:

AUXILIARY_OUTPUT_MODE

This logic value lets the software know how the auxiliary output is configured. Set Auxiliary
Output_Mode = 3 to turn on an indicator lamp when in PTO mode.

EXTERNAL_ANALOG_MODE

This logic value lets the software know how the external analog input is configured (see
“Calibrating APECS Features”).

SWITCH_CONFIGURATION
This logic value lets the software know how the speed switch inputs are configured

Calibration Procedures

Select the appropriate analog input mode and configure the external analog and
switched inputs according to your application.

In the PTO “ON” mode, select the speed with speed switches. In PTO “OFF” mode, use
the pedal or the pot to adjust the speed.

As a safety feature (in drive-by-wire mode only), when the engine is initially turned on,
the mode is assumed to be PTO “OFF” regardless of the PTO switch setting. Users
have to cycle the PTO switch “OFF” and then back “ON” to enable PTO input.

CAUTION
If a drive-by-wire mode is being used (003, 013, 023, 103, 113, 203, 213) the engine
is not allowed to start up in PTO mode.

PTO is locked out until the engine has started and the PTO switch is transitioned
from its off position.

Set Speed Calibration FAQ

After a power down/power up reset, does APECS remember the last speed
it was using?

No. The only data APECS retains after power down are the calibration parameter
settings. If you are using the variable speed mode, you will have to reestablish the
desired speed after the engine is restarted.

However, if you are configured for one of the four set speed modes, then APECS will
command the same speed on the next power up, after an optional warm up period, as
long as the switches haven’t been changed.

If using variable speed mode, what is the initial speed command when the
engine starts?

SET_SPEED_WARMUP. Even if WARMUP_TIME is set to 0, this will be the initial
engine speed command. It does not change until the engine is running and the toggle
switch is pressed. The toggle switch has no effect when the engine is not running.
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If using the 4-speed modes, what is the initial speed command when the

engine starts?

That depends on your use of a warm up speed. If you're using a warm up speed,
enabled by setting WARMUP_TIME to a non-zero value, then the first speed
commanded will be SET_SPEED_WARMUP. If you are not using a warm up speed, disabled
by setting WARMUP_TIME to zero, then the first speed commanded is selected by the
speed switches.

Can | command the engine to stop without powering down APECS?

Yes, if you are using 2-, 3-, or 4-speed mode. Simply set one of the set speeds to 1.
When you select that speed with the switch, the engine will follow the command to 1.
Usually powering off the APECS unit shuts down the engine and the throttle is
immediately closed. However, if you command a shutdown with the switch, and the
ramp down rate is set low, the engine will be stopped in a ‘soft shutdown’ manner.

When the engine starts, does the desired engine speed jump right to the
initial speed command?

No. For a smoother start, desired engine speed ramps to the initial speed command
from SET_SPEED_MIN. SET_SPEED_MIN is independent from the other 4 set
speeds. It may be set to any value, above or below the other speeds. The
recommended value for SET_SPEED_MIN is the low idle speed of the engine.
Remember that SET_SPEED_MIN is also the minimum variable speed commanded
when lowering engine speed with the toggle switch.

Speed Input Configuration Parameters

Calibration Procedures

SPEED_TYPE electrically configures the input circuitry for the speed input type and
also specifies how electrical noise is to be detected and rejected.

PULSES_PER_UPDATE and PULSES_PER_REV are factory set to prevent the unit
from calculating an engine speed and driving the actuator.

These two parameters must be calibrated to a non-zero value before normal APECS
operation can begin.

Calibration Parameters Needing Configuration:

SPEED_TYPE

Factory set for a mag pickup. This parameter electrically configures the input circuitry
for the speed input type and also specifies how electrical noise is to be detected and
rejected. Recommended values are as follows:

Mag Pickup: 128

Coil Ignition: 2
Magneto Ignition: 3
Hall Effect Sensor: 131

PULSES_PER_UPDATE

The number of pulses received by the controller between engine speed calculations and
updates.

The fewer the pulses, the faster the update rate and the lower the resolution; the
greater the pulses, the greater the averaging effect on calculated engine speed. Factory
set to zero. Must be non-zero to operate.
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PULSES_PER_REV

The number of teeth on the engine speed pickup wheel (mag pickup input and Hall
Effect sensor), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution, you must determine the kind of speed signal
input used on your application:

Magnetic Pickup Input or Hall Effect Sensor
Pulses per revolution = number of teeth on the flywheel

Woodward Mini-Gen® Signal Generator
Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at
other than crankshaft speed

Spark Ignition Input
Pulses per revolution = 1 for single cylinder engine with magneto
and one wasted spark

Pulses per revolution = number of cylinders / 2 for multi cylinder
engine with distributor

PULSES_PER_REV FAQ

How does PULSES_PER_REV work when using the ignition signal for engine
speed?

When an ignition signal is used to detect engine speed, the input pulses relate directly
to cylinder firing events rather than teeth on a flywheel. The controller measures the
time between the input pulses from the ignition. To accurately calculate engine speed, it
must know how many ignition pulses are occurring in each engine revolution; this is
PULSES_PER_REV.

The number of ignition pulses per engine revolution will vary depending on the engine
type. Factors that must be known include: how many cylinders the engine has, whether
there is a distributor, and if a waste spark is generated.

Are there any general guidelines?

Yes. Single cylinder engines typically use a magneto with a firing spark and a wasted
spark. The firing spark occurs at the end of the compression stroke, once every 2
engine revs. The wasted spark occurs at the end of the exhaust stroke, 360° later.
Therefore, the signal from the ignition will have one pulse per engine revolution.
PULSES_PER_REV = 1.

With multi-cylinder engines using a distributor, the primary ignition signal will have one
pulse for every cylinder-firing event. Since each cylinder is fired every 2 revs,
PULSES_PER_REV = number of cylinders + 2.

PULSES_PER_REV must be an integer; no half pulses allowed. The ignition signal from
a 3-cylinder engine will have 3 pulses per 2 engine revs, which works out to 1.5 pulses
per engine rev.

To work around this situation, assign PULSES_PER_REV = 3. Then the calculated
engine speed will be exactly half actual speed. If the engine is operating at 1800 rpm,
displayed engine speed will be 900 rpm. Therefore all set speeds must be half of the
actual target speed.
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CAUTION: If you forget and set the desired speed to 1800 rpm, the engine will speed
up to 3600 rpm in order to reach the target.

Engine Start Calibration Parameters
This section covers parameters for engine start calibration

Autocrank

On a command from an auto-start switch (using PTO input), an engine will go through
an autocrank sequence (using auxiliary output). This feature is useful for remote
operation of certain engines or applications.

Caution: To effectively use the autocrank feature, the actuator should be able to stop
the engine, otherwise an ignition cutoff type system must be provided.

Calibration Parameters Needing Configuration:

AUTOCRANK_CRANK_TIME

Specifies the maximum time, in seconds that the engine will crank. If the engine starts
during the crank period, engine cranking will be terminated. Range: 0-31.9 seconds.

AUTOCRANK_MAX_TRIES

Maximum number of crank/rest cycles before autocrank logic stops trying to start the
engine and flags a fault. Range: 0-255.

AUTOCRANK_REST_TIME

If the engine does not start during the cranking interval, cranking will be disabled for
AUTOCRANK_REST_TIME seconds in order to permit the starter motor to cool. Range:
0-31.9 seconds.

AUXILIARY_OUTPUT_MODE

This parameter is used to let the software know how the auxiliary output of APECS
5000 is to be configured. See “Auxiliary Outputs” for settings.

Calibration Procedures

The autocrank feature is enabled by setting AUXILIARY_OUTPUT_MODE to 4. PTO is not
available with autocrank.

When the auto-start switch is made, the autocrank output becomes active for
AUTOCRANK_CRANK_TIME (sec) or until the engine starts. If the engine does not start,
then the output goes inactive for AUTOCRANK_REST_TIME (sec), and then another
crank attempt is made. The sequence is repeated for AUTOCRANK_MAX_TRIES. If the
engine has not started after the maximum crank attempts have been made, a fault is
flagged.

When the auto-start switch is turned off, actuator duty cycle is set to zero to shut down
the engine.

Engine Cranking

The engine cranking parameters control how APECS will drive the actuator during
cranking.

Calibration Parameters Needing Configuration:
54 Woodward




APECS 5000° Electronic Engine Speed Governing System Manual SE-4096

CRANK_2_RUN

Speed transition point indicating engine has gone from crank mode to run mode (rpm).
Once engine rpm rises above CRANK_2_RUN rpm, it is assumed that the engine is in
run mode.

CRANK_DUTY_CYCLE
The fixed duty cycle used to drive the actuator when the engine is cranking (percent).

May be calibrated to a maximum duty cycle for diesel engines that require full rack for
starting, or a minimum duty cycle for some spark-ignition engines that require closed
throttle for starting.

NOTE: This parameter is preset to a value that will work with most engines and
applications. Entering new values for these parameters is optional.

KEY_ON_DUTY_TIME

The actuator will be driven at CRANK_DUTY_CYCLE following key-on reset for
KEY_ON_DUTY_TIME (in seconds) while there is no input speed signal. Once a valid
speed signal is detected, normal operation ensues. This is useful for applications that
do not generate a speed input signal at crank (e.g. genset which senses engine speed
from the generator output). When using this feature, the duty cycle does not cut back
until a valid input speed signal is seen, or the timeout period is up. If there is never a
valid input speed, the actuator will continue to be driven at CRANK_DUTY_CYCLE even if
the engine is running. This could lead to an overspeed situation. Default value: 0

Calibration Procedures

CRANK_DUTY_CYCLE may be calibrated to a maximum duty cycle for diesel engines
that require full rack for starting, or a mid-range duty cycle for some spark-ignition
engines that require a partially open throttle for starting.

In run mode, control is closed-loop; the actuator is driven as necessary to maintain the
set desired speed.

Setting KEY_ON_DUTY_TIME (seconds) to a non-zero value will cause the actuator to be
driven to the crank duty cycle, even if no engine speed signal is present. The actuator is
energized at key-on reset for the set amount of time. This may be useful for generator
applications where it is desirable to sense engine speed from the generator frequency.

To keep speed voltage below 75 Vs, a step down transformer may be necessary.
When this feature is used, it is especially important to have a redundant overspeed

protection device because a broken speed input wire could cause the engine to run at
wide open throttle for up to KEY_ON_DUTY_TIME.

Diagnostics Calibration Parameters
This section covers diagnostic calibration parameter configuration.
Engine Protection Input
User selectable input to protect against adverse conditions such as high coolant
temperature or low oil pressure. In case of oil pressure, allows the engine time for oil
pressure to rise following startup.

Calibration Parameters Needing Configuration:
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ENGINE_PRTCT_RUN_TIME

The time, in seconds, that the engine must be running before the engine protection
logic begins to monitor the engine protection input.

This permits the APECS 5000 to automatically account for oil pressure switches and
similar devices that indicate a fault condition when the engine is not running. Setting
ENGINE_PRTCT_RUN_TIME to 8000 or more will disable the engine protection option.

ENGINE_PROTECT_TIME

The amount of time spent with the engine protection input made before the actuator is
shut down (msec).

The APECS 5000 has a dedicated engine protection switch input. The engine protection
feature must be enabled by setting ENGINE_PRTCT_RUN_TIME to a value less than
8000. Once the engine has been in run mode longer than ENGINE_PRTCT_RUN_TIME, if
the engine protection input is grounded for longer than ENGINE_PROTECT_TIME
milliseconds, the governor will go into shutdown mode and the fault lamp will flash a
four code.

Calibration Procedures

ENGINE_PRTCT_RUN_TIME is set to the time in seconds the engine must be running
before a grounded signal on the engine protection input will be serviced. If
ENGINE_PRTCT_RUN_TIME is set to 0, then the input will also inhibit any actuator duty
cycle at cranking if the engine protection switch contacts are closed. The input must be
made before engine shutdown (actuator output) will begin.

If the engine has been running longer than ENGINE_PRTCT_RUN_TIME, and the engine
protection input has been made continually (not intermittently), then the actuator will be
shutdown and a fault will be generated. The lamp on the APECS unit will flash to
indicate the fault, and the fault will be cleared when the engine is restarted.

Overspeed / Underspeed Protection

This feature incorporates user selectable overspeed and underspeed parameters that
affect engine shutdown.

Calibration Parameters Needing Configuration:

OVERSPEED_RPM
Critical engine speed used for overspeed protection (rpm).

Set OVERSPEED_RPM to zero if overspeed protection is not desired. Normal closed-
loop governing will decrease the duty cycle to the actuator any time engine speed is
above the set point. Overspeed protection immediately shuts off the actuator when an
overspeed condition is detected. Engine speed must be brought back to zero before the
actuator is driven again. Setting OVERSPEED_RPM to zero disables the overspeed
protection feature. Default value: 0.

UNDERSPEED_RPM
Minimum engine speed used for underspeed shutdown (rpm).

Normal closed-loop governing will increase the duty cycle to the actuator any time
engine speed is below the set point. Underspeed shutdown immediately shuts off the
actuator when an underspeed condition is detected. Engine speed must be brought
back to zero before the actuator is driven again. Setting UNDERSPEED_RPM to zero
disables the underspeed protection feature.
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UNDERSPEED_RUN_TIME

Amount of time the engine must be in run mode before underspeed shut down is
activated (seconds).

Calibration Procedures

The overspeed protection feature immediately shuts off the actuator when the engine
runs above OVERSPEED_RPM. Setting the OVERSPEED_RPM value to zero disables this
feature.

The underspeed protection feature immediately shuts off the actuator when the engine
rem runs under the UNDERSPEED_RPM value. Set the UNDERSPEED_RUN_TIME value
as desired. Setting the UNDERSPEED_RPM value to zero disables the underspeed
protection feature.

When an engine overspeed/underspeed condition is detected, the engine protection
control logic causes: (1) the actuator duty cycle to go immediately to zero (2) a fault
code activation which is signified by LED flashing. After engine protection control logic
tripping, the fault code will continue to flash the LED. This signifies to the user that the
engine stopped due to overspeed or underspeed engine conditions. The engine may
later be restarted without resetting the unit; this action will cause the fault code to reset
and the LED will then stop flashing.

Overspeed FAQ
How Does Overspeed Work?

The APECS 5000 has the diagnostic capability to detect and react to an overspeed
condition. The feature uses two programmable parameters, OVERSPEED_RPM and
OVERSPEED_TIME. Overspeed feature immediately shuts off the actuator when the
engine runs above OVERSPEED_RPM for OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the shut
down, and a small value will hasten it. A value as small as zero can be used, which
means that the first occurrence of engine speed being over OVERSPEED_RPM will result
in a shut down. This is too sensitive and the engine could be shut down in the unlikely
event that noise on the speed signal input caused a high miscalculation of engine
speed. A minimum value of 250 msec is recommended. The user should realistically
determine an overspeed tolerance time.

When an overspeed condition is detected, the duty cycle goes immediately to zero. This
should stop the engine or at least drive it to minimum speed. A fault code is generated,
and the LED flashes. The fault will continue to flash so that the user is made aware of
why the engine stopped. The engine may be restarted without resetting the unit. The
fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor will
decrease the duty cycle to the actuator any time engine speed is above the set point.
So ordinarily, overspeed is not necessary. It is disabled by setting OVERSPEED_RPM to
zero. However, if a user feels the need for a more aggressive response to an
overspeed condition, the overspeed diagnostic feature may be used.
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Actuator Output Calibration Parameters

This section covers actuator output calibration parameters configuration.

Stepper Motor Configuration

STEP_MAX_STEP

Maximum travel of stepper motor actuator in steps of 1.8°. This, if the actuator requires
a travel of 90°, set STEP_MAX_STEP = 50. Default value = 40 steps (72°).

STEP_MODE
Determines operating mode of the stepper motor: Default value = 0.

0 = normal closed-loop governing mode

1 = step position follows pedal position provided EXTERNAL_ANALOG_MODE is non-zero.
2 = step position = STEP_CAL

3 = stepper motor sweeps continuously between 0 and STEP_MAX_STEP

STEP_CAL

When STEP_MODE = 2, specifies desired stepper motor position. Default value = 0
steps.

STEP_CONFIG

Bit field specifying stepper motor direction of travel and resolution. Default value =
00000011

X 00000YZ

Where: X = direction bit
Y,Z = resolution:
00 = whole steps
01 = half steps
10 = quarter steps
11 = eighth steps

STEP_PRD

Stepper motor pulse period, in microseconds. Setting STEP_PRD too low will cause the
stepper motor to lose count and go to the incorrect position. Default value = 4000 usec

STEP_WAIT

Stepper motor delay period, in microseconds, when reversing stepper motor direction
and doing stop/start operations. Setting STEP_WAIT too low will cause the stepper
motor to go to the incorrect position.

Calibration Procedures

1. After installing stepper motor to bracket and connecting linkage, apply power to
APECS 5000. Make certain engine is not running and cannot start.

2. If a potentiometric input is being used, make certain that it has been calibrated
and EXTERNAL_ANALOG_INPUT is set to a non-zero value, e.g. 2. (Refer to
sections 4.4.1 and 4.4.3)

3. Set STEP_MODE = 1 to configure the stepper motor to follow the potentiome-
ter. Display parameters app_norm and step. Move the pot to evaluate stepper
motor range and direction of travel. As app_norm varies between 0 and 1, step
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should vary between 0 and STEP_MAX_STEPS. When step equals 0, the ac-
tuator should be at closed throttle position. If not, change the value of the most
significant bit of STEP_CONFIG (the direction bit), being careful to leave the
two least significant bits equal to 1. Adjust STEP_MAX_STEPS to achieve full
travel. When done, set STEP_MODE = 0.

4. If a potentiometric input is not available, set STEP_MODE = 2 and STEP_CAL
= 0. The actuator should move to the closed throttle position. If not, change the
value of the most significant bit of STEP_CONFIG (the direction bit), being
careful to leave the two least significant bits equal to 1. After changing
STEP_CONFIG, cycle power to the APECS 5000 controller and the stepper
motor should move to the closed position. Set STEP_CAL =
STEP_MAX_STEPS and the actuator should move to the fully open position. If
not, adjust both STEP_CAL and STEP_MAX_STEPS. When done, set
STEP_MODE = 0.

If desired, the stepper motor can be configured to cycle continuously between closed
and open by setting STEP_MODE = 3. When doing this, look for lost steps. It may be
necessary to adjust STEP_PRD or STEP_WAIT to prevent lost steps. Note: reducing
the step rate does not always eliminate lost steps — sometimes increasing the step rate
will improve performance. In general, increased inertia of the throttle mechanism will
detract from stepper motor performance.

Auxiliary Output

The auxiliary output feature is a multipurpose output that can drive a lamp or a relay.
(See wiring information in Chapter 2.) Because a stepper motor failure can cause a
runaway engine condition, it is strongly recommended that the auxiliary ouput be
configured as an engine shutdown (AUXILIARY_OUTPUT_MODE = 2).

Calibration Parameters Needing Configuration:

AUX_OUTPUT_RPM

When AUXILIARY_OUTPUT_MODE = 1, APECS 5000 turns on the auxiliary output when
engine rpm exceeds this speed. The auxiliary output turns back off if engine speed falls
20 rpm below AUX_OUTPUT_RPM.

AUXILIARY_OUTPUT_MODE
This parameter is used to let the software know how the auxiliary output of APECS
5000 is to be configured.

Calibration Procedures

Set the AUXILIARY_OUTPUT_MODE value to the settings below to achieve a target
configuration for a certain APECS 5000/engine system setup.

VALUE AUXILIARY OUTPUT RESULT
0 No output
1 ON when engine speed is above AUX_OUTPUT_RPM
2 ON when there is an active diagnostic shutdown condition;
use with auxiliary shutdown device
3 ON when PTO is engaged; use with PTO indicator lamp
4 Autocrank output, use to drive engine crank motor relay
5 Mimics on-board LED (ON when engine speed present,

flashes faults)
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Droop Governing

When governor droop is non-zero, governed speed reduces with increasing load. Droop
may be desirable in certain load sharing applications (e.g., two gensets tied to the same
electrical bus). When droop is set to zero, governed speed will be insensitive to load
(isochronous).

Calibration Parameters Needing Configuration:

DROOP_STEP_MAX
Value of “step” when operating at maximum engine load. Used in conjunction with the
droop governing feature.

DROOP_STEP_MIN
Value of “step” when operating at no engine load. Used in conjunction with the droop
governing feature.

DROOP_PERCENT
Desired engine droop. Range: 0-15%. Droop is calculated as follows:

Droop=(step—DROOP_STEP_MIN) / (DROOP_STEP_MAX—DROOP_STEP_MIN)
Calibration Procedures

When operating in droop governing mode, the engine speed decreases (droops) as the
load is increased.

Monitor parameter “step” at no load and at full load and set DROOP_STEP_MIN and
DROOP_STEP_MAX to these values respectively. Set DROOP_PERCENT to desired
droop up to 15%.

Load is inferred by measuring the actuator sense current output of the current driver.

Set DROOP_PERCENT to zero for isochronous governing.
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Chapter 5
Troubleshooting
|
Troubleshooting Guidelines
Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and duty
cycle such as a Fluke 87.

1. Check battery voltage for stability and correct value. The LED will turn on for
one second when the APECS 5000 is first powered up.

2. For Model 4100 (magnetic pickup), check that the speed signal is at least 2
Vrus Using the AC volt settings on voltmeter. Actuator should go to full travel
during cranking. The LED will illuminate when it senses an engine speed.

3. Check the actuator linkage for binding and backlash.

4. Check that the actuator has sufficient force to reach the starting and rated load
positions.

5. Confirm normal operation of engine under manual control.

6. Confirm that the load (e.g., voltage regulator on generator) is not inducing
instability.

7. Try adjusting the gains to achieve stability.

Fault Codes

The APECS 5000 controller is capable of identifying certain fault conditions and alerting
the user to them. A flashing LED indicates the fault conditions. The current fault code
list is shown in Table VI. Please note the following:

1. When power is first applied to the controller, the LED will flash just once for one
second to indicate that the LED is working.

2. If there are multiple faults, the LED will flash them all in sequence. Count the
flash codes to determine the fault conditions or connect the Calibration Tool to
observe the fault conditions. (Use the “Display Faults” option under the Monitor
Menu.)

3. If there are no faults, the LED will flash once at reset and from then on indicate
the detection of engine speed. A continuous ON LED indicates that a valid
engine speed is being sensed.

4. The controller will attempt to shut down for some faults and will not permit
starting after reset with faults 1, 5 and 8.
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FLASH ENGINE
COI?E FAULT SHUT?)OWN CORRECTIVE ACTION

1 APECS unit Yes Calibrate APECS unit.

not calibrated
Check parameter settings. Overspeed criteria may
be too sensitive.
Check for electrical noise entering controller.

5 Engine speed Yes Check wiring and connections.
excessive

Check case ground.
Make sure linkage moves freely, without backlash.
Check tip of speed sensor.
Check parameter settings.
Engine speed .

3 unusually low Yes Check linkage and the actuator travel.

Ensure that load is not greater than engine capacity.
Engine
shutdown Check parameter settings.

4 due to engine Yes i o
protection Check what may have triggered the protection input.
input

If calibration file is available, download calibration file
and cycle power again.

5 Fac_tory | Yes
settings lost If controller still does not work or if no calibration file

is available, consult factory.
External pot N Verify that pot is wired correctly.
0

6 out-of-range Recalibrate external pot.
Accelerator

7 position / idle No Verify that signals are working and synchronized.
switch conflict

Electrical noise may be entering controller.
Controller unit v Check wiring, shielding and connections to controller.
; es

8 failed Cycle power to engine.

If controller still does not work, consult factory.
Check wiring and actuator for open circuit or short to

9 Stepper motor No ground.

driver fault
Replace controller.
Engine speed (Active only in Autocrank mode)

10 input signal No Check speed sensor wiring.
missing Check starter motor.
Autocrank

11 unable to start No Check fuel.
engine
Qlljt)('t?g No Check the lamp or relay hooked to the output. If fault

12 shoF;ted is still present, consult factory.

Battery voltage o

13 too high Yes Reduce voltage if it is greater than 38 Vdc.
Stepper motor Check stepper motor wiring and linkage.

62| 4 does not Yes Check STEP_PRD_ and STEWQgiyard
respond to - - -
command Check for excessive engine load.
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Calibration Setup & Configuration Parameters Flowchart

Step 1 Step 2 Step 3
o »-
Zc‘fé_llj_g) the APECS Calibration Tool Configure speed input EE—— Configure stepper motor

Computer '
Direction
Speed Type
mag pickup = 128 T SIEP_CONFIG
Coil Ignition = 2 ravserep MAX_STEP
Magneto Ignition = 3 Timing N N
Hall Effect = 131 STEP_PRD
STEP_WAIT
Y

Speed Input Configuration
PULSES_PER_REV
PULSES_PER_UPDATE
These two parameters must be

calibrated to a non-zero value before
normal APECS operation can begin

The APECS 5000 is a user configurable engine speed governor and will follow your
settings and commands immediately. It is possible to enter values in the APECS
module that are in excess of what the engine is capable of performing and outside of
safe operating range. Itis the user's responsibility to pay attention when entering
data into the APECS or the ACT. Entering values outside of safe operating range
can result in serious physical injury and/or damage to the equipment or application.
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Step 4 Step 5
—® Calibrate the selected features by » Determine how you would liketo [—————————— ™
configuring the listed parameters configure the speed set-point logic
Engine Cranking Default No external analog input Speed Momentary
CRANK DUTY CYCLE 95 Use speed switch to select up to four Switch Switch
CRANK 2 RUN 750 RPM discreet speeds or use momentary OR
KEY ON DUTY TIME 0 switch to increase or decrease speed %
— - at preset rates |
Engine Protection Input
ENGINE_PROTECT_RUN_TIME
default = 8000 (disabled)
Overspeed/Underspeed Trim Mode Speed : >
Protection All disabled by Switch Trim Pot
OVERSPEED_RPM default Use external pot to trim the selected 0
UNDERSPEED_RPM set speed @ @ L
UNDERSPEED_RUN_TIME
Auxiliary Output Default
AUXILIARY_OUTPUT_MODE 0 Set Speed with pot Cresd Pot »
AUXILIARY_OUTPUT_RPM 0 Use external pot to adjust set speed. P
PTO is available.
Droop Governing Default
DROOP_STEP_MAX 0 Speed Pot 4 % » gp_ete:
DROOP_STEP_MIN 0 OFF f ON  Switsh |
DROOP_PERCENT 0
PTO
A E—
PTO Input
EXTERNAL_ANALOG_MODE
SWITCH_CONFIGURATION ) R
Drive-by-wire Pecial
Similar to set speed with pot but with
additional fault management. Suitable »
for pedal applications.
E—
PTO is available
Idle verification switch is available Pedal oy
pee .
O::F % C;N Swiitch
—
PTO @
0
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Step 6

Select appropriate external analog
mode

Step 7

Calibrate the required parameters
to configure engine speed input

SWITCH_CONFIGURATION 1-4
i ——
Use speed switch (EXTERNAL_ANALOG MODE = 000) o | SET_SPEED 1-4
Use momentary switch (EXTERNAL_ANALOG_MODE = 000)
~—» SWITCH_CONFIGURATION =5
SET_SPEED_MIN I .
SET_SPEED_MAX
Trim Mode (EXTERNAL_ANALOG_MODE = 001) | SWITCH_CONFIGURATION 1-4
»| SET_SPEED 1-4
SET_SPEED_TRIM L
Trim Mode, reverse pot (EXTERNAL ANALOG MODE = 101) o | SET_SPEED_MIN
"] SET_SPEED_MAX
Set speed with pot EXTERNAL_ANALOG_MODE = 002) -
SET_SPEED_MIN
ET_SPEED_MAX ——
Set speed with pot EXTERNAL_ANALOG_MODE = 102) > SET_S -
Set speed with pot, PTO Available EXTERNAL_ANALOG_MODE = 012) > SWITCH_CONFIGURATION 1-4
SET_SPEED 1-4 »
Set speed with pot, PTO Available EXTERNAL_ANALOG_MODE = 112) SET_SPEED_MIN
» SET_SPEED_MAX
Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE =003) -
. . SET_SPEED_MAX
Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE =103) »| SET_SPEED_MAX e
Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE
=203} —
Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE =013) -
| SWITCH_CONFIGURATION 1-4
Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE =113) ] SET_SPEED 1-4
Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE SET_SPEED_MIN >
=213} —m| SET_SPEED_MAX
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Step 8

Calibrate any additional
parameters , if needed.

l

RAMP_DOWN_RATE
RAMP_UP_RATE
SPEED_DECREASE DELAY
SET_SPEED_WARMUP
WARMUP_TIME

External Pot Calibration

set the parameter
EXTERNAL_ANALOG_MODE to 255 and run

the external pot or pedal through it's full
range of travel. The controller will
learn and store the minimum

-
The external pot calibration needs to be
calibrated for use in the desired speed mode.
| The calibration process is automatic. Simply
>
>
»

and range values in tits memory. Set
EXTERNAL_ANALOG_MODE back to the

™ sdesired speed mode when finished.

4

SET_SPEED_WARMUP
WARMUP_TIME
RAMP_DOWN_RATE
RAMP_UP_RATE
SPEED_DECREASE_DELAY
(PTO only)

Step 9

Calibrate any additional
parameters , if needed.

PID Gains Adjustment
DERIVATIVE_GAIN
INTEGRAL_GAIN
PROPORTIONAL_GAIN
MASTER_GAIN

oo\

Rem —/— RP

Actul oM

™e

PID Gains too high

son)

Integral gain too high or

derivative gain too low

iR At RoM
- — = — oo rou ANANANANANANANA
e
e
PID Gains too low Derivative gain too high
Remove Losd N

Actual RPM

N A Lond

T™ME TME

Integral gain too low

Desired response
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Glossary of Technical Terms

ACT (All-Purpose Calibration Tool) Software
PC software program for configuring and calibrating the APECS controller

Actuator
Device that converts an electrical signal from the APECS controller to an output shaft
position. APECS 5000 uses a stepper motor actuator.

APECS (Advanced Proportional Engine Control System)
Engine governing system developed by Woodward

APP
Analog Pedal Position. An analog input with voltage proportional to the desired engine
speed

Autocrank
An APECS feature that allows remote or automatic starting of the engine

Cal File
File containing APECS calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the controller in
operation quickly

Control Strategy
The version of software residing in the controller

Duty Cycle
Percentage of time a pulse width modulated (pwm) signal remains on

Parameter
Numerical value that helps the user calibrate the APECS controller

PTO
Power Take-off. An APECS feature that allows selection between pedal input and
speed switch

PWM (Pulse Width Modulation)

Means of simulating analog output with a digital device. The PWM duty cycle
determines the equivalent analog output: the higher the duty cycle, the higher the
equivalent analog output.

Speed Sensor
Device such as a magnetic pickup that senses engine speed

Stepper Motor
An electro-mechanical rotary actuator that moves in discrete steps. Stepper motors are
small in size, high in torque, and low in current draw.
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Chapter 6.

Service OBtions

Product Service Options

The following factory options are available for servicing Woodward equipment, based
on the standard Woodward Product and Service Warranty (5-01-1205) that is in effect
at the time the product is purchased from Woodward or the service is performed:

e  Replacement/Exchange (24-hour service)

e Flat Rate Repair

e  Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of an

installed system, the following options are available:

e  Consult the troubleshooting guide in the manual.

e  Contact Woodward technical assistance (see “How to Contact Woodward” later in
this chapter) and discuss your problem. In most cases, your problem can be
resolved over the phone. If not, you can select which course of action you wish to
pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need of
immediate service. It allows you to request and receive a like-new replacement unit in
minimum time (usually within 24 hours of the request), providing a suitable unit is
available at the time of the request, thereby minimizing costly downtime. This is also a
flat rate structured program and includes the full standard Woodward product warranty
(Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of a
scheduled outage, to request a replacement control unit. If the unit is available at the
time of the call, it can usually be shipped out within 24 hours. You replace your field
control unit with the like-new replacement and return the field unit to the Woodward
facility as explained below (see “Returning Equipment for Repair” later in this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus shipping
expenses. You are invoiced the flat rate replacement/exchange charge plus a core
charge at the time the replacement unit is shipped. If the core (field unit) is returned to
Woodward within 60 days, Woodward will issue a credit for the core charge. [The core
charge is the average difference between the flat rate replacement/exchange charge
and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and
avoid additional charges, the package must be properly marked. A return authorization
label is included with every Replacement/Exchange unit that leaves Woodward. The
core should be repackaged and the return authorization label affixed to the outside of
the package. Without the authorization label, receipt of the returned core could be
delayed and cause additional charges to be applied.
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Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This
program offers you repair service for your products with the advantage of knowing in
advance what the cost will be. All repair work carries the standard Woodward service
warranty (Woodward Product and Service Warranty 5-01-1205) on replaced parts and
labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the
exception that the unit will be returned to you in “like-new” condition and carry with it the
full standard Woodward product warranty (Woodward Product and Service Warranty 5-
01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for
repair, please contact Woodward in advance to obtain a Return Authorization Number.
When shipping the item(s), attach a tag with the following information:

name and location where the control is installed;

name and phone number of contact person;

complete Woodward part number(s) and serial number(s);

description of the problem;

instructions describing the desired type of repair.

é CAUTION

To prevent damage to electronic components caused by improper handling,
read and observe the precautions in Woodward manual 82715, Guide for
Handling and Protection of Electronic Controls, Printed Circuit Boards, and
Modules.

Packing a Control

Use the following materials when returning a complete control:

protective caps on any connectors;

antistatic protective bags on all electronic modules;

packing materials that will not damage the surface of the unit;

at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
a packing carton with double walls;

a strong tape around the outside of the carton for increased strength.
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Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the Customer
Service Department [1 (800) 523-2831 in North America or

+1 (970) 482-5811]. They will help expedite the processing of your order through our
distributors or local service facility. To expedite the repair process, contact Woodward in
advance to obtain a Return Authorization Number, and arrange for issue of a purchase
order for the item(s) to be repaired. No work can be started until a purchase order is
received.

NOTE

We highly recommend that you make arrangement in advance for return
shipments. Contact a Woodward customer service representative at

1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and
for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
e the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
e the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 1519
1000 East Drake Rd
Fort Collins CO 80522-1519, USA

Telephone: +1 (970) 482-5811 (24 hours a day)
Toll-free Phone (in North America): 1 (800) 523-2831
Fax: +1 (970) 498-3058

For assistance outside North America, call one of the following international Woodward
facilities to obtain the address and phone number of the facility nearest your location
where you will be able to get information and service.

Facility Phone Number
Brazil +55 (19) 3708 4800
India +91 (129) 230 7111
Japan +81 (476) 93-4661
The Netherlands +31 (23) 5661111

You can also contact the Woodward Customer Service Department or consult our
worldwide directory on Woodward’s website (www.woodward.com) for the name of
your nearest Woodward distributor or service facility. [For worldwide directory
information, go to www.woodward.com/ic/locations.]
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Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales
support for Woodward products. For these services, you can contact us by telephone,
by email, or through the Woodward website.

e  Technical Support
e Product Training
e Field Service

Contact information:
Telephone: +1 (847) 967-7730
Fax: +1 (847) 967-7832
E-mail: info_niles@woodward.com
Website—www.woodward.com/ic

Technical Support is available through our many worldwide locations or our authorized
distributors, depending upon the product. This service can assist you with technical
questions or problem solving during normal business hours. Emergency assistance is
also available during non-business hours by phoning our toll-free number and stating
the urgency of your problem. For technical support, please contact us via telephone,
email us, or use our website and reference Customer Services and then Technical
Support.

Product Training is available at many of our worldwide locations (standard classes).
We also offer customized classes, which can be tailored to your needs and can be held
at one of our locations or at your site. This training, conducted by experienced
personnel, will assure that you will be able to maintain system reliability and availability.
For information concerning training, please contact us via telephone, email us, or use
our website and reference Customer Services and then Product Training.

Field Service engineering on-site support is available, depending on the product and
location, from one of our many worldwide locations or from one of our authorized
distributors. The field engineers are experienced both on Woodward products as well
as on much of the non-Woodward equipment with which our products interface. For
field service engineering assistance, please contact us via telephone, email us, or use
our website and reference Customer Services and then Technical Support.

Woodward 71



APECS 5000° Electronic Engine Speed Governing System Manual SE-4096

Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information. Please
write it down here before phoning:

General
Your Name
Site Location
Phone Number
Fax Number

Prime Mover Information
Engine/Turbine Model Number
Manufacturer

Number of Cylinders (if applicable)
Type of Fuel (gas, gaseous, steam, etc)
Rating
Application

Control/Governor Information
Please list all Woodward governors, actuators, and electronic controls in your system:

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

If you have an electronic or programmable control, please have the adjustment setting positions or the
menu settings written down and with you at the time of the call.
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We appreciate your comments about the content of our publications.

Send comments to: icinfo@woodward.com

Please include the manual humber from the front cover of this publication.

M, WOODWARD

PO Box 1519, Fort Collins CO 80522-1519, USA
1000 East Drake Road, Fort Collins CO 80525, USA
Phone +1 (970) 482-5811 ¢ Fax +1 (970) 498-3058

Email and Website—www.woodward.com
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Woodward has company-owned plants, subsidiaries, and branches,
as well as authorized distributors and other authorized service and sales facilities throughout the world.

Complete address / phone / fax / email information for all locations is available on our website.
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